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Preface 

Overview 

VS-Q series HMI is a new generation of economical HMI products, which supports various communication 

modes, has powerful configuration functions, and can realize multi-level communication through RS485, 

RS422, RS232 and Ethernet interfaces. 

HMITOOL is a kind of configuration software used to quickly construct and produce embedded computer 

monitoring system. In the collection of many years of experience in the development and application of 

configuration software, based on the use of advanced computer software technology, window as a unit, the 

construction of the user to run the system's graphical interface, through the acquisition of on-site data 

processing, animation display, alarm processing, process control and report output, and other ways to 

provide users with solutions to solve practical engineering problems, to meet the user for a variety of 

automation equipment for a variety of needs, has a wide range of applications in the field of automation. 

This manual introduces how to operate the VS series screen configuration software HMITOOL. Please read 

this manual carefully to ensure proper use. 

Targeted readers 

This manual applies to the following readers:  

¸ Electrical engineers  

¸ Software engineers  

¸ Application engineers  

About documentation obtaining 

The users using this product for the first time should read this manual carefully first. If you have any doubts 

about some specific functions and performance, feel free to consult our technical support personnel for 

assistance, which is beneficial for the correct use of this product.  

This manual is not delivered along with the product. To obtain an electronic version of the PDF file, you can:  

Log in to the official website of INVT at www.invt.com to download PDF files. 

No. Change description Version Release date  

1 First release. V1.0 Jan 2025 
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1 Product overview 

This chapter summarizes the hardware part of VS-Q Series HMI, introduces the hardware dimension of 

products, structure, hardware parameters and wiring, including the models of VS-043QE, VS-043QS, 

VS-070QE, VS-070QS, VS-070QS-G, VS-102QS, VS-102QS-G, VS-156QS, VS070QS VS-1618MDM1. Users can 

install the operation according to the relevant dimensions of the product. For details on the hardware 

performance part of the product, refer to the specific reference values. 

1.1 Product introduction 

INVT VS-Q series HMI is a high-quality human-machine interface product. The entire HMI integrates the CPU 

unit, input and output unit, display screen, memory and other module units. It can be widely used in control 

systems in all walks of life. The optimized design of software and hardware makes the product meet the 

needs of machine control in terms of touch accuracy and accuracy, as well as screen color. 

VS-Q series HMI has made great improvements on the previous basis. Compared with before, the startup 

speed is faster, the page switching speed is faster, the communication speed is also faster, and the HMI 

sensitivity is higher. 

1.1.1 Product features 

No. Feature description 

1 
Using ARM Cortex_A7 1GHz , dual-core processor, the operation speed is faster, the power 

consumption is smaller, and the operation is more stable. 

2 
Using a four-wire resistive touch panel, the touch precision is accurate, durable, and the 

touch life is long. The display is TFT LCD with 16,770,000 true color display. 

3 
Adopt anti-interference, anti-high voltage, lightning strike design, enhance the accuracy 

and reliability of communication, support RS232, 485, 422 communication. 

4 The FLASH which is kept after power off is used as ROM, and the access speed is fast. 

5 Adopt high-precision switching power supply, low power consumption. 
 

1.1.2 Product models 

VS-Q series HMIs are available in the following models:  

Model Size (inch) Resolution 

VS-043QE 4.3 480Ó272 

VS-043QS 4.3 480Ó272 

VS070QS-1618MDM1 7.0 800Ó480 

VS-070QE 7.0 800Ó480 

VS-070QS 7.0 800Ó480 

VS-070QS-G 7.0 1024Ó600 

VS-102QS 10.2 1024Ó600 

VS-102QS-G 10.2 1024Ó600 

VS-156QS 15.6 1920Ó1080 

Take the model VS-070QS-G for example: 

VS: Indicates the VS series of HMI 

070: Indicates the size (7.0 inches) 

Q: Indicates the model number 
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S: Indicates the type. E: Indicates that the HMI is an economical type (Without Ethernet); if it is S, it means 

that the HMI is a standard type(With Ethernet). 

G: Indicates support for IoT expansion (Note: 15.6 inches comes standard with IoT expansion) 

1.2 Mounting dimensions 

The following is detailed introduction to mounting dimensions of VS-Q Series HMI. Please install HMI in 

accordance with fixed mounting dimensions to avoid damaging products. 

Model Dimensions (unit: mm) Installation hole size (unit: mm) 

VS-043QE 139Ó86Ó31 110Ó6. 

VS-043QS 139Ó86Ó31 /10Ó6. 

VS-070QE 203Ó145Ó35 192Ó138 

VS-070QS 203Ó145Ó35 192Ó138 

VS-070QS-G 203Ó145Ó35 192Ó138 

VS070QS-1618MDM1 203Ó145Ó56.45 192Ó138 

VS-102QS 273Ó211Ó40 259Ó201 

VS-102QS-G 273Ó211Ó39.5 259Ó201 

VS-156QS 395Ó257Ó31 383Ó246 

 

Figure 1-1 Installation dimensions of VS-043QE 
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Figure 1-2 Installation dimensions of VS-043QS 
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Figure 1-3 Installation dimensions of VS-070QE 

190mm

3
9

m
m

203mm

1
4

5
m

m

192mm

1
3

8
m

m

 



HMITOOL Configuration Software Application Manual Product overview 

202501(V1.0) 4 

Figure 1-4 Installation dimensions of VS-070QS 
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Figure 1-5 Installation dimensions of VS-070QS-G 
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Figure 1-6 Installation dimensions of VS070QS-1618MDM1 
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Figure 1-7 Installation dimensions of VS-102QS 
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Figure 1-8 Installation dimensions of VS-102QS-G 
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Figure 1-9 Installation dimensions of VS-156QS 
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1.3 HMI Structure 

The entire structure of INVT VS-Q series HMI consists of display area, indicator light, power interface and 

communication ports. Color of all models accords to the industrial design standard, with the feature of 

soiling resistance so as to work in harsh factory environment, and indicator lights on the front panel meant 

to check the equipment status (Except VS-043QE/QS). Power interface and communication ports are located 

at the bottom of the HMI, which meets the design criteria (Except VS-156QS). The following figure shows the 
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structure of the HMI (VS-070QS-G for example). 

 

Type Description 

Power Interface Used to connect 24V DC power supply to power the HMI 

Communication Interface Communicate with PLC 

Ethernet port 
Used for communication and program uploading and 

downloading, supporting Modbus TCP/IP 

USB-B 
Used to insert U disk, upload, download programs or external 

mouse and other devices 

USB-A Connect with PC; download the configuration file from PC to HMI 

1.3.1 Power interface 

The power interface of the INVT VS-Q Series HMI locates in the back panel. With DC24V power supply (­ 

15%), it shields effectively against interference, enhancing the anti-disturbance performance of the entire  

system. The following figure is a view of power interface: 

 

 

1.3.2 Front panel 

The following figure is a view of front panel, including display screen and indicator lights(Except 

VS-043QE/QS). 
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1.3.3 Communication Port 

Communication ports of HMI are located in the bottom panel (Except VS-156QS). The communication 

interface is in the form of a 9-pin communication port and a 2-pin serial port for connection to a PLC or other 

controller and also for communication. 

When using a shielded cable, RS232 communication distance shall not go over 15 meters. For connection to 

the computer, it has a USB communication interface used for downloading configuration (data 

transmission). The transmission rate can be up to 10Mbps. Definition of communication interface differs if it 

is connected to different PLC (Please inform us the type of PLC to be connected when ordering for 

facilitating the distribution of communication cables). 

Take VS-070QS-G as an example. Its communication interface is shown as follows. 

 

1.3.4 9-pin communication port 

VS-Q series communication interface DB9 male header pinout diagram is as shown in the following figure. 

 

This port is used to connect PLC or other controllers with RS232 / RS422 / RS485 communication port. The 

number of COM ports varies among different models of DB9 interfaces. For specific details regarding the 
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number of COM ports and their definitions, please refer to the VS-Q Series HMI selection manual. The pin 

definitions are as shown in the table below. 

Pin COM1:RS232 COM2:RS422 COM2:RS485 COM3:RS485 

1 - - - B- 

2 RX - - - 

3 TX - - - 

4  - - A+ 

5 GND - - - 

6 - RX- - - 

7 - RX+ - - 

8 - TX- B- - 

9 - TX+ A+ - 
 

1.3.5 Running indicator lights 

Indicator lights of the HMI consist of three LEDs, including Power (PWR), Run (RUN) and  

communications (COM), just as shown in the following figure: 

 

PWR turns green when it is powered; 

RUN turns yellow if CPU works normally while it lights out if CPU fails; 

COM turns yellow when the HMI is communicating. 

The following table shows the display states of the 3 LED indicator lights on different working state.  

Device state Green LED (PWR) Yellow LED (RUN) Yellow LED (COM) 

No power supply п п п 

Power on т   

CPU running т т  

Communication with 

connected device 
т т ȣ 

п: LED is OFF   т: LED is ON   ȣ: LED is flashing 
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1.4 Technical parameters 

1.4.1 VS-043QE and VS-043QS 

Model VS-043QE VS-043QS 

Display 

Display size 4.3" 4.3" 

Resolution 480Ó272 480Ó272 

Screen material ITO 

Color depth 24bits 

Brightness(cd/m2) 400 

Backlight type LED 

Backlight life (hr) 20000 

Touch panel type 4-wire high accuracy touch panel 

CPU and memory 

CPU Cortex-A7 1GHz (dual core) 

Memory 128MB DDR3 

Flash 128MB FLASH 

Communication interface 

USB USB HostÓ1,USB ClientÓ1 

Serial 

interface 

COM1 RS232 RS485 

COM2 RS485/422 - 

COM3 - - 

Ethernet - Support 

WIFI - - 

Power supply 

Rated voltage 12ȏ24VDC(­15%) 

Rated power 3W 3W 

Environment 

Work temperature -20ȏ55¬C 

Work humidity 5ȏ95%RH (No condensation) 

Protection level IP65 (front panel) 

Certification 

CE EN55032,EN55035 

FCC compatibility FCC,Class A 

Dimensions and weight 

Physical dimension  

W*H*D (mm) 
139Ó86Ó31 139Ó86Ó31 

Hole dimension 

A*B (mm) 
132Ó80 132Ó80 

Weight (g) 200 214 

Configuration 

Configuration software HMITOOL 

Note: 

- Indicates not supported 

* In the serial interface, DB9 is a male socket 
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1.4.2 VS-070QE, VS-070QS, and VS-070QS-G 

Model VS-070QE VS-070QS VS-070QS-G 

Display 

Display size 7" 7" 7" 

Resolution 800Ó480 800Ó480 1024x600 

Screen material ITO 

Color depth 24bits 

Brightness(cd/m2) 450 

Backlight type LED 

Backlight life (hr) 20000 

Touch panel type 4-wire high accuracy touch panel 

CPU and memory 

CPU Cortex-A7 1GHz (dual core) 

Memory 128MB DDR3 

Flash 128MB FLASH 

Communication interface 

USB USB HostÓ1,USB ClientÓ1 

Serial 

interface 

COM1 RS232 RS232 RS232 

COM2 RS485/422 RS485/422 RS485/422 

COM3 RS485 RS485 RS485 

Ethernet - Support Support 

SD card slot - 

WIFI - - Support 

Power supply 

Rated voltage 12ȏ24VDC(­15%) 

Rated power 4W 4W 4W 

Environment 

Work temperature -20ȏ55¬C 

Work humidity 5ȏ95%RH (No condensation) 

Protection level IP65 (front panel) 

Certification 

CE EN55032,EN55035 

FCC compatibility FCC,Class A 

Dimensions and weight 

Physical dimension  

W*H*D (mm) 
203Ó145Ó35 203Ó145Ó35 203Ó145Ó35 

Hole dimension 

A*B (mm) 
192Ó138 192Ó138 192Ó138 

Weight (g) 700 700 700 

Configuration 

Configuration software HMITOOL 

Note: 

- Indicates not supported 

* In the serial interface, DB9 is a male socket 
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1.4.3 VS-102QS and VS-102QS-G 

Model VS-102QS VS-102QS-G 

Display 

Display size 10.2" 10.2" 

Resolution 1024x600 1024x600 

Screen material ITO 

Color depth 24bits 

Brightness(cd/m2) 450 

Backlight type LED 

Backlight life (hr) 20000 

Touch panel type 4-wire high accuracy touch panel 

CPU and memory 

CPU Cortex-A7 1GHz (dual core) 

Memory 128MB DDR3 

Flash 128MB FLASH 

Communication interface 

USB USB HostÓ1,USB ClientÓ1 

Serial 

interface 

COM1 RS232 RS232 

COM2 RS485/422 RS485/422 

COM3 RS485 RS485 

Ethernet Support Support 

SD card slot - 

WIFI - Support 

Power supply 

Rated voltage 12-24VDC(­15%) 

Rated power 7W 7W 

Environment 

Work temperature -20ȏ55¬C 

Work humidity 5ȏ95%RH (No condensation) 

Protection level IP65 (front panel) 

Certification 

CE EN55032,EN55035 

FCC compatibility FCC,Class A 

Dimensions and weight 

Physical dimension  

W*H*D (mm) 
273Ó211Ó40 273Ó211Ó40 

Hole dimension 

A*B (mm) 
259Ó201 259Ó201 

Weight (g) 1050 1050 

Configuration 

Configuration software HMITOOL 

Note: 

- Indicates not supported 

* In the serial interface, DB9 is a male socket 
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1.4.4 VS-156QS 

Model VS-156QS 

Display 

Display size 15.6" 

Resolution 1920x1080 

Screen material ITO 

Color depth 24bits 

Brightness(cd/m2) 300 

Backlight type LED 

Backlight life (hr) 15000 

Touch panel type 4-wire high accuracy touch panel 

CPU and memory 

CPU Cortex-A7 1.2GHz 

Memory 256MB DDR3 

Flash 4G(EMMC)  

Communication interface 

USB USB HostÓ1 

Serial interface 

COM1 RS485/422/232 

COM2 RS485 

COM3 - 

Ethernet Support 

SD card slot - 

WIFI Support 

Power supply 

Rated voltage 12ȏ24VDC(­15%) 

Rated power 10W 

Environment 

Work temperature -20ȏ55¬C 

Work humidity 5ȏ95%RH (No condensation) 

Protection level IP65 (front panel) 

Certification 

CE EN55032,EN55035 

FCC compatibility FCC,Class A 

Dimensions and weight 

Physical dimension  

W*H*D (mm) 
395Ó257Ó31 

Hole dimension 

A*B (mm) 
383Ó246 

Weight (g) 2450 

Configuration 

Configuration software HMITOOL 

Note: 

- Indicates not supported 

* In the serial interface, DB9 is a male socket 
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1.5 Wiring 

VS-Q Series HMI requires DC 24V power supply. The following figure shows the connection of the HMI with 

PLC and PC: 
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2 Quick start of HMITOOL 

This chapter introduces installation of HMITOOL configuration software, as well as basic functions and main 

characteristics of the software. It also introduces in detail the composition of the software system and the 

functions of each component, helping users to understand the overall structure framework of HMITOOL 

configuration software. In addition, it introduces the hardware and software requirements of HMITOOL, and 

the installation process and working environment of HMITOOL, helping users to learn use of this software 

and create application projects. 

2.1 HMITOOL introduction 

Created for the HMI of INVT VS-Q series from Shenzhen INVT Electric Co.,Ltd, HMITOOL configuration 

software is a development system with an integrated development environment and abundant, advanced 

functions. Taking advantage of the Windows system, it shows its simplicity and good interface consistency. 

The menu Layout close to that of Windows operating, it is facile to learn and apply, thus engineers can easily 

develop their proper projects for the configuration used in the HMITOOL. It features a decrease of time to 

develop automation projects and to upgrade, maintain the system, as well as a seamless integration with 

third-party applications and productivity enhanced 

Functions and features of HMITOOL are summarized below: 

1. Screen 

INVT VS-Q series HMI is equipped with 16.77 million display colors, much more bright compared with 

products of other manufacturers. Using HMITOOL, engineers can find it more convenient and efficient to 

design configuration projects benefitting from bright colors and rich gallery. When downloaded to HMI, the 

configuration displays exactly what PC screen shows without image distortion. Meanwhile the operation 

interface of HMITOOL is clear and concise, consistent with the design of layout menu of Windows. Taking 

advantages of major display configuration software and HMI configuration software, it is available to 

configure a high-performance and high-quality engineering document. 

2. Complete Functions 

HMITOOL provides complete functions, including basic drawing shapes, color rendering, text rendering, 

library system, animation, bitmaps status, trend display, alarm control, etc.. HMITOOL is even equipped with 

new multiple sets of recipes and historical data, controls effects of pressing and so on. All what is needed for 

engineers to achieve an expected success is designing programs and configurations according to their own 

demand project features. 

3. Communication 

HMITOOL supports PLC communication drivers of major manufacturers in the world, such as INVT, Siemens, 

Mitsubishi, Omron, Fujitsu, Panasonic, Schneider, Emerson, etc., covering the very most of them. At the 

same time we can customize certain PLC communication drivers. 

4. Resource 

HMITOOL provides abundant resources where Gallery contains three-dimensional indicator lights, 

three-dimensional buttons, motors, three-dimensional tank, three-dimensional pipes, electronic, bar graphs, 

etc., and lots of them come with graphic animation, so you can create a live animation. It supports a custom 

gallery and images inserted from Windows. HMITOOL also provides rich functions of controls, such as trends 

and alarm controls, etc., to meet the needs of various configurations. 
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2.2 System requirements 

2.2.1 Computer configuration requirements 

The basic configuration of the HMITOOL programming environment is shown in the following table: 

Item Minimum Configuration Recommended Configuration 

CPU 
Equivalent to Intel's Pentium D805 or 

above 

Equivalent to Intel's Pentium Dual G4620 or 

above 

Memory 4GB Above 4GB 

Graphics card 
Functional in 1280 Ó 640 resolution  

and 256 color mode 

Functional in 1280 Ó 640 resolution and  

65535 color mode 

hard disk Above 500MB Above 64G 

OS Windows 7 and later Windows 7 and later 

Communication 

ports 
Type C port, RJ-45 

Other devices Power supply 

2.2.2 How to get HMLTool 

HMITOOL is free, and users can download the software installation package in the application software 

options of "Support" > "Download" on INVT official website (www.invt.com). 

Our Company is constantly improving products and materials, so the users should update the software 

version in time when they need it, and consult the latest released reference materials, which is beneficial to 

the program design of users. 

2.2.3 HMITOOL software installation process 

The HMITOOL installation package released by Shenzhen INVT Electric Co., Ltd. is a separate executable 

program whose installation process can be started by double-clicking. 

1. Follow the installation wizard step by step. Users can choose different installation paths as required. 

2. After installation, the HMITOOL program group will appear in the Start menu; at the same time, the 

installer will also install the HMITOOL shortcut icon on the desktop. 

3. Double-click the shortcut icon to run the program. 

4. Uninstall: The software can be uninstalled through Windows Control Panel. 

Note: To upgrade and install the new version of HMITOOL, please uninstall the old version of HMITOOL 

first. 

2.3 HMITOOL running interface 

The main interface of this program basically includes 6 parts: menu bar, toolbar, Project manager, toolbox, 

workspace and "Messages output" window. 



HMITOOL Configuration Software Application Manual Quick start of HMITOOL 

202501(V1.0) 17 

 
 

No. Name Description 

˔ Menu bar 

Programming software operation menu, including editing, parameter 

setting, language selection and other related settings, file 

management and screen programming shortcuts. 

˕ Toolbar 
Shortcuts to commands button; Display file; open project; new 

project; restoration and other function buttons. 

˖ Project manager 

Communication connections, parameter settings, image 

management, alarm settings, set recipe and tree-form menu set by 

historical data collector. 

˗ Toolbox 
Basic configuration controls designed for engineers to configure; 

contain function controls and basic controls. 

˘ Workspace Window for engineering staff to configure, edit graphic object.  

˙ 
"Messages output" 

window 

Prompts concerning information input, output, error messages and 

other tips as engineers conduct configuration editing and compiling. 
 

 

2.3.1 Menu bar 

Editing menu bar of HMITOOL configuration software provides users with an extensive menu options, 

almost covering all the engineering tools and editing commands needed. The menu bar includes File menu, 

Edit menu, View menu, Draw menu, Object, Screen menu, Setting menu, Tools menu, Help menu, Language 

selection menu, and also a Right-click menu. The menu bar is shown below: 

 

1. File  

"File" menu supports operations of New project (Ctrl+N), Open Project (Ctrl+O), Close, Save (Ctrl+S), Save As 

and Quit (Ctrl+Q). If a certain item shows gray, it indicates that the operation is invalid in the current 

environment. The method of opening the file menu is to click "File (F)" on the top left corner of the software, 

and then it ejects a pull-down File menu toolbar. 
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¸ New Project: shortcut key Ctrl + N; to create a blank project. 

¸ Open Project: shortcut key Ctrl + O; to open a project file created, saved before and suffixed by .vpm. 

¸ Close: to close the current project file without exiting HMITOOL configuration software. 

¸ Save: shortcut key Ctrl + S; to save the current configuration file having been modified, the name and 

save path of the file are by default as before. 

¸ Save As: to save the current configuration file; available to override the name and save path of the 

project. 

¸ Exit: to exit HMITOOL configuration software. 

2. Edit 

"Edit" menu consists of a set of commands used to edit texts, graphics and other content in the screen. 

There are Undo, Restore, Cut (T), Copy (C), Multiple copy (D), Paste (P), Delete (D), Select All (A), Align, Layer, 

Group, Mirror, Zoom, Grid, Property setting, Find Address, Address Table, Reverse Select, Macro search, 

Macro Manager. If a command in the menu bar is gray, it means in current operation, that command is 

invalid. To executive these commands, you should first select the graphic object to be edited, and then 

choose the corresponding command in "Edit" menu. But there are in "Edit" menu some commands that are 

group commands. If so, a little triangle will show on the right of the command and each command, with a 

drop-down menu, has a corresponding shortcut, as shown in the figure below: 

 

¸ Undo: shortcut key Ctrl + Z; to cancel the last operation command and your recent action. 

¸ Restore: shortcut key Ctrl + Y, to restore the last operation command and your recent action. 

¸ Cut: shortcut key Ctrl + X, to delete your selected graphical objects and copy them into the clipboard 

buffer. 

¸ Copy: shortcut key Ctrl + C; to copy the selected graphic object into the paste buffer. 

¸ Multiple copy: to copy a quantity of selected graphical objects in horizontal and vertical directions, and 
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then the address can be in ascending order of 0-255 units.  

¸ Paste: shortcut key Ctrl + V, to copy and paste buffer graphics objects into the current screen. 

¸ Delete: Del, to remove selected graphical object from the screen. 

¸ Select all: shortcut key Ctrl + A; to select all objects in the current frame of the project. 

¸ Align: to make selected objects (more than two) aligned according to the selected type alignment, 

including Top, Bottom, Vertical Center, Left, Right, Horizontal Equal Interval, Vertical Equal Interval, 

Make same width, Make same height, Make same width and height. 

¸ Layer: to place the selected objects to a different image level. You can choose Bring To Top, Bring 

Forward, Send to Bottom or Send Backward. 

¸ Group: to combine selected objects (more than two) into one control, or split This command can be 

selected more than one object (two or more) are combined into a control, an object can also can split a 

detachable object or split combined objects into the original object. When using Group, please be sure 

not to assembly objects to touch, otherwise objects cannot be touchable after being downloaded to 

the HMI. Layer is recommended if it is necessary to overlay touchable objects. 

¸ Mirror: to rotate the selected object in accordance with certain rules, horizontally or vertically. 

¸ Zoom: to zoom the current screen in accordance with a certain proportion scale for a more fine control 

operation; zoom options are Zoom In, Zoom Fit and Zoom Out. 

¸ Grid: to place or cancel a grid with certain width in the current screen.  

¸ Property settings: to open the Properties window of an object (when one single object is selected) and 

that of a screen (when nothing is currently selected). 

¸ Find Address: to find the address you are using. 

¸ Address Table: to open or close the list of addresses being used. Address Table is a list of address used 

by objects, easy to find and replace. 

¸ Invert Selection: to select all objects not being chosen in the current screen and objects that are chosen 

before are not included. 

¸ Macro Search: to locate calls of the macro in the project; you can optionally specify to search or 

manually enter the search. 

¸ Macro Manager: Execute this command to see locations of all macros used; you can choose to display 

macros of all the screens or those of a specific screen. 

Note: When using Assemble key, do not assemble objects to be touched, or it cannot be touched after 

downloading to the HMI. Users may use Layer command to superpose touch objects. 
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3. View 

This menu allows developers to custom their operating interface according to their own habits: decide 

whether certain operating window is shown in the current operating environment. The icon P on the left of 

the command means the display of the toolbox on the screen, otherwise it is hidden.  

 

4. Draw 

The menu is mainly used to draw graphics on the screen. HMITOOL provides straight line (L), Polyline (B), 

Curve/Arc (A), Free Lines, Rectangles (R), Round Rectangle, Ellipse (E), Polygon (Y), Arc, Text (T), Open Library 

(0), Build Library (C), Table, Scale. It's convenient for engineers to change the color, text, size and location of 

graphic elements created by the Tools menu. 

 



HMITOOL Configuration Software Application Manual Quick start of HMITOOL 

202501(V1.0) 21 

¸ Line: Execute this command to draw a straight line in any direction within the current screen. 

¸ Polyline: Execute this command to draw a polyline in any direction within the current screen. 

¸ Curve/Arc: Execute this command to draw a line in the current screen, after finishing drawing by right 

button, the radian of drawings can be adjusted as needed. 

¸ Free line: Execute this command to draw a line in the current screen in any direction, lines are drawn 

with the movement of the mouse. 

¸ Rectangle: Execute this command to draw a rectangle of any size in the current screen. 

¸ Rounded Rectangle: Execute this command to draw any rectangle with rounded corners in the current 

screen. 

¸ Ellipse: Execute this command to draw any size of ellipse in the current screen. 

¸ Polygon: Execute this command to draw an arbitrary polygon in the current screen. 

¸ Arc: Execute this command to draw any sector in the current screen. 

¸ Text: Execute this command to create a transparent rectangle where you can enter any text inside. 

¸ Open Library: Execute this command to open the image library of the system. 

¸ Build Library: Execute this command to convert the image control drawn by user into a file of library; it 

is easy to operate next time. 

¸ Table: Execute this command to create a table with required ranks in the current screen. 

¸ Scale: Execute this command to draw a desired scale. 

5. Object 

"Object" menu consists of a set of touch keys and function keys, including Bit Switch, Word Switch, Screen 

Button, Function Button, Multifunction key, Stepping Button, Single Button, Combo Box, Sliders, Numerical 

Display, Numerical Input Display, ASCII Display, ASCII Entry, Bit Lamp, Multistate Switch, Multistate Lamp, 

Message display, Time Display, Date Display, Weekday Display, Static Picture, Picture Display, GIF Display, 

Dynamic Diagram, Dynamic circle, Dynamic Rectangle, Flowing block, Graphics Move, Animation, Bar Graph, 

Meter, Arc chart, Trend Chart, XY Trend Chart, Historic trend, Data group, Historical data, Alarm Control, 

Alarm Bar, Historical Alarm, Timer, Message Board, Recipe selector, Recipe data display, Keyboard and 

Qrcode.  
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¸ Bit switch: Execute this command to create touch keys for performing bit manipulations to the 

connected device, including Set ON, Set OFF, Dot and Invert. 

¸ Word switch: Execute this command to set a touch key for performing word bit operation in the current 

screen to the connected device, including Add, Subtract, Increasing, Decreasing, Set Constant, Enter 

Value, Enter Password. 

¸ More: Execute this command to reach the Screen Button, Function Button, Multifunction key, Stepping 

Button, Single button, Combo Box and Sliders. 

¸ Numerical display: This command is used to draw on the current screen a numerical display frame 

reflecting numerical value of certain monitored address. 

¸ Numeric input display: Execute this command to draw on the current screen a numerical display frame 

for data input and digital value display of certain monitored address. 

¸ ASCII display: Execute this command to draw on the current screen a numerical display frame for ASCII 

code.  

¸ ASCII input display: This command is used to draw on the current screen a frame of display and output 

for the input of ASCII code. 

¸ Bit lamp: Execute this command to create on the current screen a graph monitoring the bit status of 

one single connected device. 

¸ Multistate switch: Execute this command to create multi-state button monitoring numerical value 

changes of single address of the connected device according to the change of status. 

¸ Multistate lamp: You can place a graph in the current screen monitoring the word status of multiple 

consecutive device addresses. 

¸ Message display: Execute this command to create a display control showing pre-configured message 
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on the current screen. 

¸ Time Display: Execute this command to insert the time control on the screen to show the time. 

¸ Date Display: Execute this command to insert the date control on the screen to display the date. 

¸ Week Display: Execute this command to insert a week control on the current screen to display the 

week. 

¸ Static Picture: Execute this command to insert a static image of the local hard disk on the current 

screen. 

¸ Picture Display: This command is used to draw a graph display frame on the current screen for 

displaying a plurality of graphs. 

¸ GIF Display: Execute this command to draw a graph display frame on the current screen to display a 

static or animated image suffixed by .GIF. 

¸ Dynamic Diagram: Execute this command to open the windows of Dynamic Circle, Dynamic Rectangle, 

Flowing block, Graphics Move and Animation. 

¸ Bar Graph: Execute this command to insert a columnar control on the current screen to observe the 

changes in the numerical value of monitored address according to the rise and fall or the right-left 

traverse of the columnar graph. 

¸ Meter: Execute this command to create an instrument on the current screen to monitor the changes of 

numerical value of single address of connected device. 

¸ Arc chart: Execute this command to insert a sector control on the current screen for reflecting the 

numerical value of monitored address and the reflection area can be presented by Pie FG Color, Pie BG 

Color or Bottom Color. 

¸ Chart: Execute this command to open the window of Trend Chart, XY Trend Chart, historical trend and 

Data group. 

¸ Historical Data: Execute this command to create a display control on the current screen to show 

messages saved by the historical data collector. 

¸ Alarm: Execute this command to open windows of Alarm Control, Alarm Bar and History Alarm. 

¸ Timer: Execute this command to insert a control on the current screen to trigger a particular function 

according to time conditions. 

¸ Message Board: Execute this command to insert on the current screen a control where users can write. 

¸ Recipe Selector: Execute this command to insert on the current screen a recipe control that shows all 

names of recipes if they exist. 

¸ Recipe Data Display: Execute this command to insert a recipe data display control on the current screen, 

which shows all the data of recipes if they are set up. 

¸ Keyboard: Execute this command to insert a keyboard control on the current screen, which can be any 

key in the keyboard when custom the keyboard. 

¸ Qrcode: Execute this command to insert a Qrcode control on the screen for user-defined Qrcode; It 

should be used in concert with an input control, otherwise the address is invalid and the Qrcode won't 

appear. 

6. Screen 

"Screen (P)" menu consists of commands applied to screens, including New Screen, Screen Properties (P) 

and Delete Screen (D). 
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¸ New Screen: Execute this command to create a new screen in the current project. 

¸ Screen Properties: Execute this command to open the properties of the current screen by which you 

can set the name and background. 

¸ Delete Screen: Execute this command to delete the current screen. 

Note: Please make sure the current screen is the one you want to delete and whether there are needed 

controls before operating causes it cannot be undone. 

7. Setting 

"Setting (s)" menu contains the following commands: Preference Settings (P), File Protection (M), Macro 

Editor, Global Macro, Initialization Macro and Add Customize Keyboard. 

 

¸ Preference Setting: Execute this command to open the preference setting window, in which you can 

modify the HMI model, display mode, splash screen, screen saver time, flicker frequency, alarm sound, 

touch sound, password and settings of initial lever. 

¸ File Protection: Execute this command to open the password setting window of file protection through 

which you can set a password to protect the file of the current project is set in the password window. 

Note: Please keep in mind the password since password is necessary to open the project 

configuration file after the setting. And it is case-sensitive. 

¸ Macro Editor: Execute this command to open the macro editor where you can add, modify, compile or 

delete a macro. 

¸ Global Macro: Execute this command to open a global macro setting screen, set or modify the global 

macros. 

¸ Initialization Macro: Execute this command to open the interface of initialization macros setting to set 

or modify initialization macros. 

¸ Add Customize keyboard: Execute this command to open a user-defined keyboard. 

8. Tools 

Applied to compile and download the configuration project, "Tools" menu contains seven commands, 

which are Off-line Simulation (M), Online simulation, Download (D), Upload, Pack/Unpack, Viewing 

compilation generated files and Layout of Screen Controls. 

 

¸ Off-line Simulation: Execution of this command can invoke the application program of HMITOOL graph 

configuration and open the simulation interface. Users can simulate the configuration project running 

currently on PC to observe the effect, in order to modify the screen. Please save it Off-line simulation 
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before you save the user first. 

¸ Online Simulation: This command can be called HMITOOL screen configuration software application, 

open the simulation panel, users can simulate engineering currently run on a PC to observe the effect, 

in order to correct the graph. When online simulation, you can also use the PC's Ethernet or serial 

communication device connected to data communications and communications test status. Please 

save it before the online simulation. 

¸ Download: Execution of this command can download engineering configuration compiled by HMITOOL 

software to HMI through a USB cable. Before downloading, please compile and save the project. 

¸ Upload: Execute this command to upload the historical data, configuration, recipes, and historical 

alarm from the HMI to a PC through a USB cable. 

¸ Pack/Unpack: Execute this command to compress the project configuration into an XXX.vpr file, or to 

extract the compressed file to the project configuration file .vpm. 

¸ Viewing compilation generated files:Execute this command to compile the current project 

configuration into a binary file. 

¸ Layout of Screen Controls: Execute this command to set text attributes, control sizes, etc. 

9. Option menu 

 

¸ Find Address: Execute this command to find the address you want and show the using status of the 

address on Information Output Window. 

¸ List of address/Window usage:Execute this command to find the status of all addresses and screens in 

all windows or specified windows. 

¸ Script search:Execute this command to check the using of the assign macro instruction, and show it on 

information ouput window. 

¸ Script Manager:Execute this command to look for all macro instructions' status on all windows or 

assigned window. 

¸ Text batch modification:Execute this command to modify the specified text in bulk. 

¸ Interface Style Settings:Execute this command to modify the style of the current interface. 

10. Help menu 

"Help" menu can call up the Help documentation and About HMITOOL: its version number and copyright 

notice. 

 

The help file is shown below: 
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Version number and copyright statement of HMITOOL are shown below: 

 

11. Language selection menu 

This menu enables switching between Chinese, English, Russian and Turkish languages of the software. It is 

shown in the figure below: 

 

Select "Chinese" to switch the language of the software to Simplified Chinese; select "English" to switch the 

language of the software to English, and the same operation mode for other languages. 

12. Right Click Menu 

Right click menu is set to facilitate user's operations, which is consistent with most Windows user's 

operating habits and styles. Lots of configuration functions can be found here: Attribute, Objects, Library, 

Cut, Copy, Multiple copy, Paste, Delete, Select all, Align, Layer, Group, Zoom, Grid, Screen. 
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¸ Attribute: Execute this command to open the properties window of a control (one single object 

selected) and the screen (no object selected). 

¸ Object: Execute this command to open all of the object controls in the Object menu. 

¸ Library: Execute this command to open the gallery or generate graphs. 

¸ Cut: Shortcut Ctrl + X; this command can delete your selected graphical objects, and copy them into the 

clipboard buffer. 

¸ Copy: Shortcut Ctrl + C; execute this command to copy the graphic object of your choice into the paste 

buffer.  

¸ Multiple copy: Execute this command to copy a quantity of selected graphical objects in horizontal and 

vertical directions, and then the address can be in ascending order of 0-255 units.  

¸ Paste: shortcut key Ctrl + V, to copy and paste buffer graphics objects into the current screen. 

¸ Delete: Del, execute this command to remove selected graphical object from the screen.  

¸ Select: shortcut key Ctrl + A; execute this command to select all objects in the current frame of the 

project. 

¸ Align: Execute this command to make selected objects (more than two) aligned according to the 

selected type alignment, including Top, Bottom, Vertical Center, Left, Right, Horizontal Equal Interval, 

Vertical Equal Interval, Make same width, Make same height, Make same width and height. 

¸ Layer: Execute this command to place the selected objects to a different graph level. You can choose 

Bring To Top, Bring Forward, Send to Bottom or Send Backward. 

¸ Group: to combine selected objects (more than two) into one control, or split This command can be 

selected more than one object (two or more) are combined into a control, an object can also can split a 

detachable object or split combined objects into the original object. 

Note: When using Group, please be sure not to assembly objects to touch, otherwise objects cannot be 

touchable after being downloaded to the HMI. Layer is recommended if it is necessary to overlay touchable 

objects. 

¸ Zoom: Execute this command to zoom the current screen in accordance with a certain proportion scale 

for a more fine control operation; zoom options are Zoom In, Zoom Fit and Zoom Out. 

¸ Grid: Execute this command to create or cancel a grid with certain width on the current screen. 

¸ Screen: Used to create a new screen, open screen property window and delete a screen. 

2.3.2 Standard toolbar 

HMITOOL offers a series of shortcut tool buttons, some of which are tool command buttons while some 

belong to editing commands. You can easily get to the needed commands here instead of seeking it in the 
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menu bar if familiar with these buttons. Each button has tooltips that will appear when the mouse is placed 

on the button. HMITOOL provides a total of 51 tool buttons, which will turn gray if the If the operation is 

invalid in the current environment. 

 

Each command in the toolbar corresponds to that in the menu, and their functions are respectively: 

Label Instruction Description 

 New Project Shortcut key Ctrl + N; to create a blank project. 

 Open Project 

Shortcut key Ctrl + O; execute this command to open a 

project file created, saved before  

and suffixed by .vpm. 

 New Screen Execute this command to create a new screen 

 
Save 

Shortcut key Ctrl + S, used to save the current screen 

configuration that has been changed, with the file name and 

directory being the same as the original. 

 Undo 
Shortcut key Ctrl + Z; to cancel the last operation command 

and your recent action. 

 Redo 
Shortcut key Ctrl + Y, to restore the last operation command 

and your recent action 

 Cut 
Shortcut key Ctrl + X, to delete your selected graphical 

objects and copy them into the clipboard buffer. 

 Copy 
Shortcut key Ctrl + C; to copy the selected graphic object into 

the paste buffer. 

 Paste 
Shortcut key Ctrl + V, to copy and paste buffer graphics 

objects into the current screen. 

 Delete Del, to remove selected graphical object from the screen. 

 Group 
Execute this command to combine several graphic objects 

you select into one object. 

 Ungroup 

This command can decompose a combination of graphic 

objects you have selected into the original graphic objects; 

it's the inverse operation of Group. 

 Flip Horizontal 
Execute this command to make a single graphic or multiple 

graphics pivot horizontally. 

 Flip Vertical 
 Execute this command to make a single graphic or multiple 

graphics pivot vertically. 

 Grid 
Execute this command to create or cancel a grid with certain 

width on the current screen. 

 Zoom In 

Execute this command to magnify the current screen two 

times; to continue to enlarge, please continue to execute the 

command. 

 Zoom Fit 
Execute this command to restore the current screen to the 

standard size. 

 Zoom Out 

Execute this command to shrink the current screen half the 

size; to continue zooming out, proceed to execute the 

command. 
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Label Instruction Description 

 Language Execute this command to select the language you want. 

 
Status 

Drop-down Box 

If select a control with status, the drop-down box will show 

the number of control status; if the number in the box 

changes, the status of the selected control will switch into 

corresponding status. 

 Screen Frames Execute this command to jump to the page you want to view. 

 
Property 

Settings 

Execute this command to get the properties of the selected 

key. 

 Locked 
Execute the command to lock the key selected on the screen 

and it cannot be moved after locking. 

 Unlock 
Execute this command to remove the locking of screen 

buttons. 

 
Find/replace the 

Button 

Click the button, and the user can find all the usage of the 

specific register and can be replaced by the other. 

 Address Find 

Execute this command to find out whether an address is 

occupied and the search results are displayed in the 

"information output window". 

 Address Display 
Execute this command to browse the used address of all 

controls in certain screens or all the screens. 

 Find Macro 

Execute this command to find whether a macro is used; the 

search result is displayed in the "information output 

window". 

 Macro Manager 
Execute this command to see the macro condition of all 

controls in certain screens or all the screens. 

 
Text Batch 

Modification 

Click this button to batch modify the text in the selected 

control, screen, or window. 

 Rotate 
Select the control, and use it to rotate freely in the center of 

the control. 

 
Off-line 

simulation 

Execute this command to run directly off-line simulation 

command. 

 
Online 

Simulation 

Execute this command to run directly online simulation 

command. 

 Download 

Execute this command to pop up the download dialog; after 

connecting the VS-Q Series HMI to PC, you can download the 

configuration project to the HMI. 

 Upload 

Execute this command to upload historical data, 

configuration, recipes and alarm history from a running HMI 

to a PC via the equipped USB cable. 

 Bring To Top (F) 
Execute this command to shift the graphic object you 

selected to the top of the screen. 

 Send To Bottom 
Execute this command to shift the graphic object you 

selected to the bottom of the screen. 

 Bring Forward 
Execute this command to shift the graphic object you 

selected forward one layer. 

 
Send Backward 

(B) 

Execute this command to shift the graphic object you 

selected backward one layer. 
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Label Instruction Description 

 
Make Same 

Width 

Use this command to make a group of selected patterning 

the same width as that marked by a black point. 

 
Make Same 

Height 

Use this command to make a group of selected patterning 

the same height as that marked by a black point. 

 

Make Same 

Width and 

Height 

Use this command to make a group of selected patterning 

the same width and height as that marked by a black point. 

 Top 
Shortcut key Ctrl + Up, execute this command to align upper 

boundaries of selected multiple graphic objects top. 

 Bottom 
Shortcut key Ctrl + Down, execute this command to align 

lower boundaries of selected graphic objects bottom. 

 Left 
Shortcut key Ctrl + Left, execute this command to left justify 

the left edges of selected graphic objects. 

 Right 
Shortcut key Ctrl + Right, execute this command to right 

justify the right edges of selected graphic objects. 

 
Horizontal 

Center 

Execute this command to align selected graphics horizontal 

center. 

 Vertical Center 
Execute this command to align selected graphics vertical 

center. 

 
Horizontal Equal 

Interval 

Execute this command to make two or more controls align 

horizontally equal interval. 

 
Vertical Equal 

Interval 

Execute this command to make two or more controls align 

vertically equal interval. 
 

2.3.3 Project manager 

HMITOOL Project Manager window is in the left of configuration software window, below the toolbar. You 

can set the parameters of the HMI, including Multi-language Settings, Connection, Setting, Screen, Window, 

Historical data collector, Alarm landing, recipe, Data transmission and Macro; Connection consists of 

Connection 1 and Connection 2 settings which contains HMI parameter settings, HMI state, PLC control, 

Clock, File encryption, HMI protection and Variable table. 
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2.3.4 Toolbox 

HMITOOL Toolbox provides a wealth of tool buttons, some of which are functional control buttons, and 

some are basic controls. After being familiar with these buttons, designers can quickly find the commands 

they need instead of searching in the menu bar. HMITOOL supports totally 55 function controls and 14 basic 

controls. 

 

      

 



HMITOOL Configuration Software Application Manual Quick start of HMITOOL 

202501(V1.0) 32 

Toolbox individual operating controls and menu content corresponding to each other, each button 

functions are: 

Label Instruction Description 

 Line 
Execute this command to draw a straight line in any direction 

within the current screen. 

 Polyline 
Execute this command to draw a polyline in any direction 

within a current graph. 

 Curve/Arc 

Execute this command to draw a line in the current screen, 

after finishing drawing by right button, the radian of 

drawings can be adjusted as needed. 

 Free Line 

Execute this command to draw a line in the current screen in 

any direction, lines are drawn with the movement of the 

mouse. 

 Circle/Ellipse 
Execute this command to draw any size of circle or ellipse in 

the current screen. 

 Rectangle 
Execute this command to draw a rectangle of any size in the 

current screen. 

 
Rounded 

Rectangle 

Execute this command to draw any rectangle with rounded 

corners in the current screen. 

 Polygon 
Execute this command to draw an arbitrary polygon in the 

current screen. 

 Arc 
Execute this command to draw any sector in the current 

screen. 

 Positive Polygon 
Execute this command to draw a positive polygon on the 

screen. 

 Text Execute this command to create a text input on the screen. 

 Table 
Execute this command to create a table with required ranks 

in the current screen. 

 Scale Execute this command to draw a desired scale. 

 Open Library 
Execute this command to open the graph library of the 

system. 

 Import Gallery 
Execute this command to import the graphics of the local 

library into HMITOOL for the engineering designers to use. 

 Bit Switch 

Execute this command to create touch keys for performing 

bit manipulations to the connected device, including Set ON, 

Set OFF, Dot and Invert. 

 Word switch 

Execute this command to set a touch key for performing 

word bit operation in the current screen to the connected 

device, including Add, Subtract, Increasing, Decreasing, Set 

Constant, Enter Value, Enter Password. 

 Screen button 

Execute this command to set the switching of screens, 

including opening screen, open the previous screen, close 

and Open screen, Closes screen, Open previous screen and 

Close open screen. 
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Label Instruction Description 

 Function button 

Execute this command to set a certain function control of the 

operating system, including Turn off background light, 

Confirm alarms, Restart HMI, Set screen saver time, Write 

recipe to PLC, Read recipe from PLC, Set the date and time, 

Clear alarm, Switch to previous recipe, Switch to later recipe, 

Save current recipe, Screenshots, System parameters, User 

login, Cancel the user login, Touch sound ON / OFF, Alarm 

sound ON / OFF, Clear all historical data, Clear alarm history, 

Unlock HMI protection, read& save recipe, Spare function, 

Overload recipe, Switch language, Print screen to printer, 

Slave devices IP configuration, DIP switches 1 and 3 feature 

set. 

 Stepping button 

Execute this command to create a stepping button control in 

the current screen to realize the cyclic switching of execution 

states. 

 Single button 

Execute this command to create a single button control in 

the current screen; click the designated state area, then the 

state will switch accordingly. 

 Combo box 

Execute this command to create a drop-down box button 

control in the current screen, for viewing and selection. Once 

user selects an item, the corresponding value will be written 

into the control address of character buffer. 

 Slider 

Execute this command to create a slider analog switch 

control in the current screen; drag the slider to change the 

value of corresponding character register addresses. 

 
Numerical 

Display 

This command is used to draw on the current screen a 

numerical display frame reflecting numerical value of certain 

monitored address. 

 
Numeric Input 

Display 

Execute this command to draw on the current screen a 

numerical display frame for data input and digital value 

display of certain monitored address. 

 ASCII Display 
Execute this command to draw on the current screen a 

numerical display frame for ASCII code. 

 
ASCII Input 

Display 

This command is used to draw on the current screen a frame 

of display and output for the input of ASCII code. 

 Bit Lamp 

Execute this command to create on the current screen a 

graph monitoring the bit status of one single connected 

device. 

 
Multistate 

Switch 

Execute this command to create multi-state button 

monitoring numerical value changes of single address of the 

connected device according to the change of status. 

 Multistate Lamp 
Place a graph in the current screen to monitor the word 

status of multiple consecutive device addresses. 

 Message Display 
Execute this command to display corresponding message 

information according to different monitoring address. 

 Recipe Selector 

Execute this command to insert on the current screen a 

recipe control that shows all names of recipes and enter, 

monitor contents of RWIO. 
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Label Instruction Description 

 
Recipe Data 

Display 

Execute this command to insert a recipe data display control 

on the current screen, which shows all the data of recipes if 

they are set up. 

 
Multi-function 

button 

Execute this command to create a multi-function button in 

the current screen to realize multiple functions through one 

key. 

 Keyboard 

Execute this command to insert a keyboard control on the 

current screen, which can be any key in the keyboard when 

custom the keyboard. 

 Time Display 
Execute this command to insert the time control on the 

screen to show the time. 

 Date Display 
Execute this command to insert the date control on the 

screen to display the date. 

 Week Display 
Execute this command to insert a week control on the 

current screen to display the week. 

 Static Picture 
Execute this command to insert a static image of the local 

hard disk on the current screen. 

 Picture Display 
This command is used to draw a graph display frame on the 

current screen for displaying a plurality of graphs. 

 GIF Display 

Execute this command to draw a graph display frame on the 

current screen to display a static or animated image suffixed 

by .GIF. 

 Dynamic Circle 

Execute this command to create a dynamic circle in the 

current screen whose size and location transform according 

to the continuous address change of connection device. 

 
Dynamic 

Rectangle 

Execute this command to create a dynamic rectangle in the 

current screen whose size and location transform according 

to the continuous address change of connection device. 

 Flow Block 
use this command to create a simulation control of flow 

state in the current screen. 

 Graph Move 

Execute this command to create a graph display frame in the 

current screen whose graphic state and location change 

according to the continuous address change of connection 

device. 

 Animation 
Execute this command to create an animation control in the 

current screen to move the control. 

 Meter 

Execute this command to create an instrument on the 

current screen to monitor the changes of numerical value of 

single address of connected device. 

 Arc Chart 

Execute this command to insert a sector control on the 

current screen for reflecting the numerical value of 

monitored address. 

 Pie Chart 

Execute this command to insert a sector control on the 

current screen for reflecting the numerical value of 

monitored address. 
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Label Instruction Description 

 Bar Graph 

Execute this command to insert a columnar control on the 

current screen to observe the changes in the numerical value 

of monitored address according to the rise and fall or the 

right-left traverse of the columnar graph. 

 Trend Chart 

Execute this command to create a trend chart control in the 

current screen to monitor the change trend of continuous 

address value of connection device. 

 XY Trend Chart 

Execute this command to create a XY trend chart control in 

the current screen to monitor the change of two continuous 

address value of connection device. 

 
Data Group 

Display 

Execute this command to create a date group display control 

in the current screen to display several groups of data in the 

trend chart. 

 
Historical Trend 

Chart 

Execute this command to create a historical trend chart 

control in the current screen to display historical data in the 

trend chart. 

 
Historical Record 

Display 

Execute this command to create a historical record display 

control in the current screen to display historical data 

collected. 

 
Historical Alarm 

Display 

Execute this command to create a display control of 

historical alarm record in the current screen to show 

historical alarm data. 

 Alarm Display 

Execute this command to create an alert box control in the 

current screen to display the date, time and message of each 

alert. 

 Alarm Bar 
Execute this command to create an alert bar in the current 

screen to scroll display alert information. 

 Operation Log 

Execute this command to create an operation log display 

frame in the current screen to display the time, user and 

contents of the operation. 

 Timer 
Execute this command to create a macro timer in the current 

screen to control the execution of the macro. 

 Message Board 
Execute this command to create a message board control in 

the current screen where users can write. 

 QRcode 

Execute this command to create a QR code control in the 

current screen to display character or number with the help 

of input control. 

 
Corner Flow 

Block 

Execute this command to create a Corner flow block control 

in the current screen to display the shape and flow speed. 

 Multi-Window 
Execute this command to create a multi-window control in 

current screen to display the assigned window. 

 
Scroll Bar 

Control 

Scroll bar control to draw different types of scroll bars for 

table data browsing. 

 Pipeline Control Pipeline control and the control of a scroll bar. 
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2.3.5 System composition 

HMITOOL is a configuration editing software of VS-Q series HMI. HMITOOL allows engineers to edit the 

configuration on the PC, and then download the final configuration and required communication driver to 

communication and the required driver to the storage mechanism of the HMI with a USB cable; HMIs can be 

controlled and monitored after being connected to PLCs or other connection devices through actuators and 

serial communication ports. The following figure shows HMITOOL system composition. 

 

2.4 Basic operations 

This chapter describes briefly the mouse usage, shortcut keys and some of the terminology of HMITOOL 

software. 

2.4.1 Mouse usage and shortcut keys 

When use the mouse to create configuration screens on the configuration screen editor, the mouse is as 

shown in the following figure: 

 

The following is several common operations of mouse and their purposes: 

¸ Left-click 

Press the button on the left side, then releaseȐthis is referred to in the book [click], used in the selection 

menu, to select the object, choose Tool buttons, edit configuration graph, confirm settings. 

¸ Double left click 

Press the button twice in rapid succession on the left sideȐthis is referred to [Double] in this book, applied 

to attribute setup for existing parts on the screen: screen and window attributes, HMI connection properties, 

set properties; to change settings of Historical data collector, recipes, alarms and other control options. 

¸ Right-click 

Press the key on the right, then releaseȐthis is referred to in the book [right-click]. Right-click on a part can 

open the right drop-down menu, or right-click in the space display the context menu. You can also quit the 

editing state, restore the mouse state. 
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¸ Drag 

Move the mouse while hold the button-- this is called in the book [drag], using the drag operation can select 

multiple items to move parts, mobile pop-up edit windows. 

While edit with HMITOOL configuration software, the shape of the mouse will changes with different 

operations to distinguish different types of operation. The following table shows available operations under 

various shapes of the mouse when edit screens: 

Mouse shape Executable operation 

 Select objects; click tool buttons 

+ Paste 

 Draw graphs 

 Input text 

 Enlarge the objet vertically 

 Enlarge the objet horizontally 

 Enlarge the objet vertically and horizontally 

 Readjust 

 Enlarge the objet vertically and horizontally 

 Rotate the object 

Table below lists common shortcut keys. Designers can use these keys to quicken the configuration. 

Shortcut keys Executable operation 

CTRL+C Copy 

CTRL+V Paste 

CTRL+X Cut 

CTRL+F Address Lookup 

CTRL+ drag Copy the selected objet and move it 

CTRL+left click Select multiple objects 

ɘɚəɛ 
Move the selected objet left and right, up and 

down 

ESC Undo the operation 

DEL Delete 

2.4.2 Common Terms 

Common Terms Description 

Project 

Shortened from user's application system. Introducing the concept of 

project means to make complex computer expertise easier for the 

general engineers. Files created in HMITOOL configuration is suffixed 

by .vpm; it can be stored in any specified location. 

Object 
Operating goals and operating environment, collectively called 

Object, such as windows, components, data, graphs and objects. 

Select the object 

Making a window or object operable by a mouse click is referred to 

select object, the selected object (including windows) is also known 

as the current object 

Configuration 
Define, create and edit object in a window environment and set its 

status feature (attribute) parameter 
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Common Terms Description 

Attribute 
Name, genre, sate, property and the usage are called collectively 

Attribute 

Menu 

A set of execution commands. For example, the system menu "File" 

menu is used to dealing with execution commands related to project 

documents. HMITOOL menus are all pull-down menus that can also 

be divided into multiple levels, each known as a sub-sub-menu 

Command Button 
Buttons with certain command operations, part of which in the 

toolbar while part of in the menu bar 

Set ON Switch the object with bit status display to sate "ON" 

Set OFF Switch the object with bit status display to sate "OFF" 

Style 
A transition effect of object from the foreground to the background 

color 

Address Memory variables related to the current object 

Connecting Device Communication devices connected to current project 

Control Set of particular functions 
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3 Basic steps of creating a new project 

This chapter introduces basic steps of creating a new project. 

3.1 Create a new project 

This operation is necessary when engineers need to create a new project. Select New Project in the File 

menu or New Project button  in the tool bar, then HMITOOL will pop up the "New Project dialog box" 

where you can decide the name and storage path of the project. Select the corresponding HMI model; click 

"OK" to complete creating a new project and enter into the dialog box of Communication port settings; click 

Cancel to exit the dialog box. 

 

1. New project dialog box 

¸ Project name: Project name of the new project 

¸ Path: Storage path of new project file; the default is C: \ 

¸ Size/Series: The model number of the HMI used in the project is selected according to the actual size 

and model number, and the default model number is VS-070QS 

¸ Show mode: Display direction of the HMI used by the project. Available models include: 

Horizontal: Configuration with the HMI being horizontal; Vertical: Configuration with the HMI being vertical. 

The default mode is Horizontal 

The figure above is the New Project dialog box where engineers decide the Name, Path, Model and Display 

Mode, then click Next to set communication port. Specific model is determined by the HMI model that user 

has. 
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Note 

¸ The name of the new project cannot contain the following characters: \ /: * "<> |?. 

¸ The location of the new project cannot contain the following characters: \ /: * "<> |?. 

2. Communication settings dialog box 

Communication settings dialog box is used to set communication parameters of the communication port of 

HMI. Only correct communication parameters can ensure normal communication between PLC and HMIs. 

The specific communication parameters depend on the model of PLC to be connected. 

¸ Connection ID: Internal parameters cannot be changed! 

¸ Connection Name: The name of the communication port. 

¸ Device Service: Selection of PLC brand and CPU type. 

¸ Connection Interface: Select COM port or Ethernet port. 

¸ PLC Continuous Address Interval: Set PLC consecutive address space; the default value is 

recommended. 

 

The figure above is the dialog box of communication port settings where engineers choose corresponding 

device services according to types of connection devices. To use Ethernet connection, choose "Direct 

Connection(Ethernet)" option in the "Connection Type". 

Note 

¸ If the HMI used has multiple COM ports (e.g., VS-102QS), when only one PLC is connected, it is 

determined by the COM port used.  

¸ If the touch panel used has only one COM port, only the COM1 port is set. 

When you configure the communication properties can also be set in the Project Manager connection, the 

other parameters are set in the communication properties. 
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3. Screen Properties settings box 

Click "Next" in the Communication settings dialog box to pop up a New Screen dialog box where you can set 

the name and the background color of screens. The default name is a screen number; the default 

background color is blue.  

When we create a new screen every time, HMITOOL configuration software will assign a screen number to 

the new screen to indicate the screen order of the current project. Numbers start from 1, that is, the serial 

number of the first frame 1. No. 5 is the fifth screen.  

To change the background color of the new screen, just click the rectangle behind the Background Color to 

bring up the color selection frame. With more than two hundred kinds of colors for users to select quickly, 

HMITOOL software provides the most extensive selection of color. If you are dissatisfied still, you can click 

on the lower right of the color selection box to customize color. In the Custom Colors dialog box, select the 

basic color first, then color in the middle of the square area; drag the mouse to adjust the desired color area; 

you can also type in the right vertical rectangle and drag the mouse to complete the desired color, at last 

click "OK". You can also enter directly basic color values. 
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Engineers can also choose own pictures as the screen background. Click the path icon to find the image 

path. 

 

Click "OK" to complete the above steps, the system will immediately open the screen you just created. 

Preparations for new construction are done. Then it's time to edit own configuration project. 

3.2 Set parameters and add graphic objects 

3.2.1 Model settings 

You can modify the parameter settings through Preference Setting in the drop-down menu Settings, or 

double-click the HMI Parameter Settings in Setting, Project Manager. Then a pop-up dialog box is shown as 

the figure below: 

¸ HMI Model: Change the HMI model through this option. 

¸ Display Mode: Adjust horizontal or vertical display screen. 

¸ HMI Size: You can select the size of the HMI by changing the content of this option. 
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3.2.2 Parameter settings 

The parameter setting screen is shown below: 
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1. HMI start setting 

¸ Splash Screen: The start screen of HMI when powered on. 

¸ Screen Saver Time: Set screensaver time 

¸ Flicker Frequency: Set the flicker frequency of objects or controls which can blink; you can change the 

speed of flicker by inputting directly a value and clicking the spin button. 

¸ Alarm Sound: When the alarm occurs, the HMI can remind users through sound; the right drop-down 

menu contains two cases, with or without sound reminder. 

¸ Touch Sound: Options in the right drop-down menu can decide Sound reminder or No sound reminder. 

¸ Screen Savers Screen: Select a screen among the existing screens as screensaver screen; just touch the 

screen to return the former screen. 

¸ Load Logo Screen: If choose this option, the HMI will display the selected loading screen after power-on 

for a certain while, and then switch to the splash screen; thus users can give some tips or notes. 

¸ External Boot Image: When this item is selected, the touch panel will display the selected external 

image after powering up, stay for the set time, and then go to the startup image. 

2. Operation mode 

¸ Touch Method: Users can choose whether to use touch operation or connect a USB mouse to operate. 

¸ Hide Mouse Cursor: Whether to display the mouse. 

3. Other settings 

Floating-point settings:  

¸ [Standard]: High byte floating point ahead while the low one behind; 

¸ [Appoint]: Users determine the order. 

4. Display controls pressing effect 

HMITOOL is newly added pressing effect display. When the pressing effect is applied, rectangular pressing 

trace will appear if users touch the control. The pressing trace color depends on user's preference. Currently 

Bit switch, Word switch, Screen button, Function button, Numeric input and ASCII input controls support 

this effect. The default is No effect. 

 

5. Invalid touch 

Select the "Use custom labeling", which means touchable controls cannot be touched, then the image 

marking the control chosen by user is untouchable. 

Note: Pressing effect of elliptical controls is still a rectangle. 

6. Alarm setting 

Alarm Sound: When an alarm is triggered, the touchscreen can provide an audio alert to notify the user. The 

dropdown menu on the right offers two options: sound alert enabled or disabled. 
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3.2.3 User password 

 

 

This function has 8 sets of user password, each of which has eight levels of password for users to choose. 

¸ The default user level: The current default user class is NULL. 

¸ Allow uploading configuration: If select this option, you can upload the project from HMI to PC; 

otherwise it cannot be uploaded. 

¸ Enter the password when uploading: Whether uploading projects requires a password. 

¸ Password when updating configuration through U disk: The password set up, the password is 

necessary when you update the HMI configuration projects through U disk. 

¸ Supreme authority password: This password can operate all controls limited by grades. 

¸ Upload: Whether this password enables upload configuration projects from HMI to PC. 

¸ Permissions: Whether this password can perform all limiting operations. 

3.2.4 Printers and download 

Settings of connection to the printer and downloading:  
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This page contains parameter settings of connection between the printer and the HMI; users can select 

corresponding parameters according to printer models. 

1. Download settings 

¸ Download mode: Users need to select USB or Ethernet connection to download. If choose the Ethernet, 

it's necessary to set the IP address and port number (IP address and port number are those of the HMI). 

¸ Clear historical alarm records: Whether to clear the history alarm information before downloading. 

¸ Clear Local area data: Whether to clear the data information saved in the power-down holding area 

when downloading; 

¸ Clear historical data records: Whether to clear the history data information before downloading. 

¸ Download recipe: Whether to download recipes in the current project to the HMI. 

¸ Clear User Permission records: Whether to clear the user permission information stored in the HMI 

before the download. 

2. Image downloading options 

Keep the original format: Selecting this option means retain the image format unchanged when 

downloading. 

Convert to JPG format: Convert all images to JPG format before downloading them into HMI. 

Note: Due to the larger space occupied by BMP format images, it's suggested to select this option. 
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3.2.5 Storage location and alarm system 

Storage location and alarm system, as shown below: 

 

1. Storage Location 

It is the location for historical data, historical alarm and screen shots. Provide "Local (FLASH)", "U disk" two 

options for users to choose according to their need. The default is Local (FLASH). 

2. Alarm System 

Use the alarm system: Whether to use the system alarm. When an alarm occurs, the alarm system displays 

the current alarm information at the top or bottom of each screen according to the options set by users. 

Alarm background color, Text color, Font and Font size, these are attributes options of the alarm display 

system. Users can set these options as needed. 

¸ Way of display: "Always display" refers to the alarm displayed all the time; "Cyclic display" means that 

alarm display or disappear within a certain period to achieve the flicker effect. 

¸ Position of alarm bar: Choose the position where the alarm bar appears. 

3. Other setting 

Other setting as show below: 
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If checking out this section, users need to input this password when unlocking the screensaver. 

Start system time password protection: When you enable this option, you need to properly enter the 

password set here when modifying the HMI system time, allowing the user to modify the HMI system time. 

4. VNC settings 

¸ Start VNC: Enable VNC Settings 

¸ VNC Port: Set the VNC port number 

¸ VNC Password: Set the VNC connection password 

The special type HMI supports remote through the VNC connection HMI operation, detailed reference to the 

"VNC connection". 
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3.3 Download configuration projects 

Step 1 When complete the editing of configuration, you need to click the button  on the toolbar or 

employ the shortcut Ctrl + S, and then click button  and wait for the system to compile. During 

the compilation, the information output window will show the situation in real time. It cannot 

complete the compilation if error exists, as shown in the figure below: 

 

You can modify it according to the error hint in the information output window; or you can also double-click 

the error, then HMITOOL will automatically find the wrong object as well as select it. So engineers can 

double-click on the object to view its property settings, find the reason of the error and make appropriate 

alterations. After click the Save button to compile and execute the command again. If there is no error, the 

system will pop up a dialog box indicating successful compilation after a while. At last, click "OK" to finish it, 

as shown in figure below: 
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Note: It's necessary to compile before downloading while the step of conservation is required before 

compiling. Otherwise it will fail to compile, as shown in figure below. After compilation, if you modify again, 

you need to compile again. 

 

Step 2 Finally, select Download HMI Configuration in the Download menu, and the engineering 

configuration designer can select any from USB, Ethernet, or Extract U disk file, as shown in the 

figure below: 

 

Step 3 Click to download; the middle progress bar shows the downloading progress. After the downloading, 

a pop-up window shows the completion of USB download. Click "OK" to complete the downloading 

task, as shown in figure below: 
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Step 4 The next step is the connection to the PLC to see whether the configuration project runs correctly in 

HMI. Ways of connection between HMI and PLC or PC are shown in "1.5 Wiring" in Hardware 

handbook. 

Note:  

Õ Do not cut off the power of HMI, PC or USB cable and avoid other operations during the transmission 

process; otherwise it will be affected. 

Õ Please install the USB drivers before downloading; otherwise the PC will not be connected to HMI. Thus 

you will not be able to complete the downloading task. 

 

Note: When the dialog box shown above pops up, it means that the version does not match or the PC fails 

to recognize the HMI, at this time you can check whether the USB driver is installed. Connect the PC and HMI, 
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power on the HMI, you can in the Windows "My Computer" > "Properties" > "Hardware " > "Device Manager" > 

"Universal Serial Bus Controller" to find out whether there is a USB driver. You can try to unplug the USB 

cable to check whether the PC can recognize the HMI. 

Downloading configuration through Ethernet 

Set HMI network parameter settings: In the download interface, set the IP and port of which the IP can be set 

according to your own needs, here set to 192.168.1.100, the port is fixed to 12345. 

Compile the configuration: If select downloading configuration through Ethernet it is necessary to input IP 

address and port number in the input box. IP is that of the downloading target HMI. The IP here is 

192.168.1.100 as above, and the port is fixed to 12345. Then click to restart and download, as shown in figure 

below: 

 

3.4 Upload configuration programs 

HMITOOL software supports uploading configuration program from the HMI to the hard disk. Connect HMI 

to PC; select "Upload Processing" in , and then select "Upload Configuration" in the pop-up dialog box, 

the interface of uploading will be displayed. Select the path where you want to save the file, click "OK", and 

then click Start Upload to save the configuration program to the selected file path. 
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Note: HMITOOL configuration software also supports uploading historical data, recipes and historical 

alarms. Selecting Upload Historical Data allows you to upload historical data from the HMI to the hard disk, 

and other similar. 

3.5 Zip/Unzip 

Select "Zip/Unzip" in the Download menu to open the dialog box. 

 

¸ Zip the file: Zip the project file to generate a compressed file suffixed .vpr. Used external images will be 

also packaged into the compressed file. If users send the compressed file to another computer, the 

images still exist after unzipping. However, if only sending the configuration project file, you will lose 

external images in other computers because the external images could not find the original image path. 

Save Path: Location to store the compressed file; after selecting the save path, Click "Compression", and 

then close it when the progress bar reaches 100%. 

¸ Unzip the file: Decompress a file-suffixed .vpr into that of .vpm which can be opened directly in 

HMITOOL. 

Zip file: Choose files to be extracted. 

Save Path: Location to store the decompressed file suffixed .vpm; after selecting the save path, click 

"Zipping", and then close it when the progress bar reaches 100%. 
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4 HMITOOL configuration guidelines 

4.1 Screen operations 

This chapter details screen operations of HMITOOL configuration. 

4.1.1 Create a new screen 

"New Screen" command is used to create a new screen in the current project. Steps of creating new screens 

are as follows: 

(1) Select the "New Screen" command in the Screen menu or click the button command  or right click 

the Screen menu in the project manager, and then select "Add Screen", as shown in figure below: 

 

(2) In the pop-up "New Screen" dialog box, set the name and background color of the new screen, then click 

"OK". The default name of the new screen is a screen number; the default background color is blue, as 

shown in figure below: 

 

 

4.1.2 Modify screen properties 

To modify the properties of the screen, including the name, background color, you can perform the 

following operations: 

Under the circumstances that no object or control is selected (you can click blank space in the current 

screen), select the  command on the toolbar or left click to select the screen in the project manager, 
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and then right click on it or you can right click in the screen while on object is selected in order to bring up 

the context menu in which you can find "Property" command. 

 

4.1.3 Delete a screen 

This command is used to delete the screen in the current project; methods are as follows: 

Select " Delete Screen" in the Screen menu; or left-click to choose the screen to be delete in the project 

manager, then right click to select "Delete" key; or right click in the blank space in the screen while on object 

is selected in order to bring up the context menu in which you can find "Delete" command. Click "Go on" to 

complete the operation of deleting. 

 

4.1.4 Copy a screen 

This command is to copy the screen in current project; methods are as follows: 

Left-click on the screen to be copy in the project manager, then right click to bring up the context menu and 

select "Copy", will be prompted to set the new screen name, enter the name, enter the screen number, and 

select "OK", the screen that is copied and listed, select "Cancel" to cancel the current operation, as shown 

below: 
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Right-click in the screen options, pop-up right-click menu, at this time, "Paste" option becomes bright, click 

"Paste" to complete the copy process. The generated copy of the screen number is automatically added one, 

the screen name for the copied screen name + "- copy", as shown below: 

 

 

4.1.5 Automatic sorting 

The automatic sort command is used to sort the screen number in the current screen. Methods are as 

follows: 

Select the project manager the screen option by clicking the left mouse button, then right-click menu select 

"automatic sorting and automatic sorting will prompt the settings screen, select the automatic sorting 

function, click "OK", can carry out sorting operation on the current screen (from small to large order). The 

specific process is shown in the following: 

Click the left mouse button options, and right-click to choose "Automatic sorting". 

 

Check the automatic sorting, and click "OK". 
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The sorting results are shown below: 

 

4.2 Graphics editing commands 

This chapter details HMITOOL graphical editing commands. 

4.2.1 Group and ungroup 

The combination command is a group command, which is to combine 2 or more graphics objects and 

controls in the current screen into a graphic object, a whole, and 2. The contents of the combination can be 

graphics drawn by engineering designers, or drawn by themselves, or can be system library graphics, or 

other controls, such as alarm controls, trends, and so on. After the combination control, keep the property 

of the original control object, which can be modified. The cancellation combination is to decompose the 

graph which is combined with the combination command into several original combination elements, and 

cancel the combination command is the reverse operation of the combination command. 

Methods of grouping:  

First it needs to select multiple graphic objects, and then select the Group command  in the Edit menu, 

or that command button in the toolbar menu, or right click to bring up the context menu and select "Group" 

item, before and after comparison picture is as figure below: 

  

Methods of ungrouping:  

Select a combined graphic object from grouping, and then select the Ungroup command in the Edit menu, 

or in the toolbar menu, or in the context menu; before and after comparison picture is as figure below: 
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Note: Select multiple objects through Ctrl key. 

4.2.2 Layer 

Layer Command is by group. It is used to adjust the display level of intersecting graphic objects. Each object 

HMITOOL has a graphic level; the top of the graphic objects are always displayed on top of the lower graphic 

objects, so you can use this command to adjust the hierarchy level. The default level of new graphic object is 

higher than that of original. HMITOOL Layer consists a total of four commands: Bring To Top, Bring Forward, 

Send to Bottom and Send Backward. To execute this command, you need first select one or more graphical 

objects on the current screen, and then select the corresponding command in the Edit menu or toolbar 

menu. 

Bring to top:  

Execute this command to move the selected graphic object to the uppermost layer of all graphic objects, so 

that the selected graphic object will overwrite the intersecting part. 

First choose an object in several graphs, and then choose Bring To Top command in Edit menu, or command 

button  in the toolbar buttons, or call the right click menu and choose Bring To Top command in the 

Layer option. See figure below for a comparison before and after combination 

  

Send to bottom:  

Execute this command to send the selected graphic object to the lowermost layer of all graphic objects, so 

that the intersecting part of the selected object will be invisible. 

First choose an object in several graphs, and then choose Send To Bottom command in Edit menu, or 

command button  in the toolbar buttons, or call the right click menu and choose Send To Bottom 

command in the Layer option. See figure below for a comparison before and after combination. 
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Bring Forward:  

Execute this command to bring the selected graphic object one level forward to the intersecting graphic 

objects. You first need to select one object in multiple graphic objects, and then select "Bring forward" in the 

Edit menu or the toolbar button, or right click to bring up the context menu containing "Bring forward" in 

the series commands of Layer. 

First choose an object in several graphs, and then choose Bring Forward command in Edit menu, or 

command button  in the toolbar buttons, or call the right click menu and choose Bring Forward 

command in the Layer option. See figure below for a comparison before and after combination. 

   

Send Backward:  

Execute this command to send the selected graphic object one level backward to the intersecting graphic 

objects. You first need to select one object in multiple graphic objects, and then select " Send backward" in 

the Edit menu or the toolbar button, or right click to bring up the context menu containing "Send backward" 

in the series commands of Layer. 

First choose an object in several graphs, and then choose Send Backward command in Edit menu, or 

command button  in the toolbar buttons, or call the right click menu and choose Send Backward 

command in the Layer option. See figure below for a comparison before and after combination. 

 

   

4.2.3 Rotary 

This command is by group. HMITOOL configuration editor software allows engineers to rotate one or more 

graphical objects at any angle. Graphic objects that can be rotated to contain straight lines, circles, 

rectangles, graphics system library, controls, a combination of graphics, and polygons. 
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Flip horizontal:  

"Flip horizontal" allows engineers to rotate the graphic object (may be a plurality of graphic objects) at 180¬

by the axis of vertical center in the horizontal plane after selecting. First select one or more graphical objects, 

then click "Flip Horizontal" in the Edit menu "Mirror" or click the Flip Horizontal button in the Tool bar . 

When a single graphic object is selected, as shown in figure below: 

  

Contrast before and after Flip Horizontal of single graph object 

Flip vertical:  

"Flip Vertical" allow engineers to rotate the graphic object (may be a plurality of graphic objects) at 180¬by 

the axis of horizontal center in the vertical plane after selecting. First select one or more graphical objects, 

then click "Flip Vertical" in the Edit menu "Mirror" or click the Flip Vertical button in the Tool bar . When 

a single graphic object is selected, as shown in figure below: 

  

Contrast before and after Flip Vertical of single graph object 

Rotating:  

Currently, only the following 12 controls are supported to support this function: Time Display, Date Display, 

Week Display, Static Picture, GIF Display, Picture, Numerical Display,  Numerical Input, ASCII Display, ASCII 

Entry, MultiState Lamp, MultiState Switch After rotation allows engineering design personnel selection 

controls, to object center as the dot, memory 360¬. Select an object, click the "rotate" command in the edit 

menu, or click the rotate button in the tools button . 

  

Contrast before and after Rotating 
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4.2.4 Alignment and size 

This command is by group, so is the Size. HMiTOOL configuration software allows engineers to operate 

alignment and size operation on multiple graphical objects, but only when multiple graphic objects are 

selected. Users can hold down the key Ctrl to select the graphic objects to be aligned, or hold down the left 

mouse button and drag to delineate them. Alignment operations include a large number of editing 

commands: Left, Right, Vertical Center, Horizontal Center, Top, Bottom, Horizontal Equal Interval and 

Vertical Equal Interval, Make same width, Make same height, Make same height and width, etc. 

Top:  

The command of Top Alignment allows engineering designers to top justify multiple graphic objects (no less 

than two graphical objects) through clicking "Top"  of the Alignment in the Edit menu or through the 

context menu. These graphic objects will take the highest edge of graphic objects as a reference, and then 

make them at the same level. Before and after comparison diagram of Top Alignment is shown in figure 

below: 

  

Before and after comparison diagram of Top Alignment 

Bottom:  

The command of Bottom Alignment allows engineering designers to bottom justify multiple graphic objects 

(no less than two graphical objects) through clicking "Bottom"  of the Alignment in the Edit menu or 

through the context menu. These graphic objects will take the lowest edge of graphic objects as a reference, 

and then make them at the same level. Before and after comparison diagram of Bottom Alignment is shown 

in figure below: 

  

Before and after comparison diagram of Bottom Alignment 

Vertical center:  

The command of Vertical center allows engineering designers to make centers of graphical objects in the 

same vertical line (no less than two graphical objects) through clicking "Vertical center"  of the 

Alignment in the Edit menu or through the context menu. This vertical line is the vertical centerline of the 

leftmost and rightmost edges. Before and after comparison diagram of Vertical Center Alignment is shown in 
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figure below: 

  

Before and after comparison diagram of Vertical Center 

Alignment 

Left:  

The command of Left Alignment allows engineering designers to left justify multiple graphic objects (no less 

than two graphical objects) through clicking "left"  of the Alignment in the Edit menu or through the 

context menu. These graphic objects will take the leftmost edge of graphic objects as a reference, and then 

make the left sides of each graphic object along the same vertical line. Before and after comparison diagram 

of Left Alignment is shown in figure below: 

  

Before and after comparison diagram of Left Alignment 

Right:  

The command of Right Alignment allows engineering designers to right justify multiple graphic objects (no 

less than two graphical objects) through clicking "Right"  of the Alignment in the Edit menu or through 

the context menu. These graphic objects will take the rightmost edge of graphic objects as a reference, and 

then make the right sides of each graphic object along the same vertical line. Before and after comparison 

diagram of Right Alignment is shown in figure below: 

  

Before and after comparison diagram of Right Alignment 

Make same width:  
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This command allows engineering designers to make multiple graphic objects (no less than two graphical 

objects) have the same width through clicking "Make same width"  of the Size in the Edit menu or 

through the context menu. These graphical objects will be reduced or enlarged by the upper left point while 

the height remains unchanged, so that the width of each graphic object is in accordance with what has been 

selected before (surrounded by black points while others by green points). Before and after comparison 

diagram of Make same width is shown in figure below: 

  

Before and after comparison diagram of Make same width 

Make same height:  

This command allows engineering designers to make multiple graphic objects (no less than two graphical 

objects) have the same height through clicking "Make same height"  of the Size in the Edit menu or 

through the context menu. These graphical objects will be reduced or enlarged by the upper left point while 

the width remains unchanged, so that the height of each graphic object is in accordance with what has been 

selected before (surrounded by black points while others by green points). Before and after comparison 

diagram of Make same height is shown in figure below: 

  

Before and after comparison diagram of Make same height 

Make same height and width:  

This command allows engineering designers to make multiple graphic objects (no less than two graphical 

objects) have the same height and width through clicking "Make same height and width"  of the Size in 

the Edit menu or through the context menu. These graphical objects will be reduced or enlarged by the 

upper left point, so that the height and width of each graphic object is in accordance with what has been 

selected before (surrounded by black points while others by green points). Before and after comparison 

diagram of Make same height and width is shown in figure below: 
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Before and after comparison diagram of Make same height and width 

Horizontal equal interval:  

This command allows engineering designers to make multiple graphic objects (no less than two graphical 

objects) have the equal interval horizontally through clicking "Horizontal Equal Interval"  of the 

Alignment in the Edit menu or through the context menu. 

Vertical equal interval:  

This command allows engineering designers to make multiple graphic objects (no less than two graphical 

objects) have the equal interval vertically through clicking "Vertical Equal Interval"  of the Alignment in 

the Edit menu or through the context menu. 

Note: Before executing commands of Make same width, same height, same width and height, please 

make sure whether the selected objects have been rotated. The height and width of rotated object also 

rotate with itself.  

4.3 Draw basic graphics 

This chapter details operations of drawing basic graphics with HMITOOL. 

4.3.1 Line 

Select the "Line" command in Draw menu or left-click the line button  in the toolbar; move the mouse 

in the screen editing window, and it will become a cross; click on the mouse in the view (i.e. screen), then a 

line is added. 

After the above steps, the transparency of the line, the line type, width, color, the arrow and shape of end 

will be set by default while engineers can modify these properties in order to meet the needs of projects. 

Double click over a straight line, or click on the Property button  in the toolbar after selecting it. Line 

Property dialog box will pop up, as shown in figure below: 
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HMITOOL configuration software provides up to 6 straight line types, 30 kinds of line width, and 6 

straight-line end arrows, with the ability to adjust the properties using the pull-down and trimming buttons. 

To change the length, direction, and position of the line, select the line first, then move the mouse to the end 

of the line; after that hold the left button of the mouse, and drag the mouse to the right position to release 

the left button. 

4.3.2 Polyline 

Select the Polyline command in the Draw menu or click the Polyline command button  in the toolbar 

to move the mouse to the Edit window. The mouse will change to a cross. That's when you can draw a 

polyline in the Edit window. 

Move the mouse to a position where you want to draw the polyline. Click the left mouse button once, and 

then a small green dot appears in the screen editing window, which is an endpoint of the polyline. 

Move the mouse to other positions in the screen, the system will automatically draw a straight line; move 

the mouse to change the direction; left click once and the place where you click will appear a small green 

box. Here the line from the first endpoint to the first small green rectangle will not move with the mouse. 

The mouse can be moved to the next point to change the direction of the polyline, just click the left mouse 

button. When you need to complete the drawing of the polyline, right click to complete drawing the polyline, 

as shown in figure below: 
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After finishing the above steps, the transparency, line type, line width, line color, end arrow and end point 

shape of the polyline will be set by default. The engineer can modify these attributes to meet the needs of 

the project. Move the cursor to the polyline; double-click the left button, or first select the line, and then 

click the toolbar property button . A dialog box same as that of Line Property will pop up. 

You can adjust the properties of the polyline using the pull-down and fine-tune buttons. The HMITOOL 

configuration software provides up to 6 straight line types, 30 kinds of line width, and 6 types of end arrow 

for polylines. To change the length, direction and position, select the line first, and then move the mouse to 

the polyline; hold down the left button of the mouse, after, drag the mouse to the appropriate location to 

release the left button. 

4.3.3 Curve/Arc 

Select the Curve/Arc command in the Draw menu or click the Curve/Arc command button  in the 

toolbar menu; move the mouse to the Edit window, then the mouse cursor will change to a cross, by now 

you can draw a curve/arc in the Edit Window. 

Move the mouse to a position where you want to curve. Left click and a small green dot appears in the 

window. This position is the start position of the curve/arc. 

Move the mouse to other position in the screen, then the system will automatically draw a straight line; after 

click the left mouse button and release. 

At this time, the mouse cursor is still cross-shaped. Move the mouse to other position in the screen, which is 

the end of the curve / arc. Hold down the left button does and move the mouse in the screen to draw the arc; 

release the mouse and right click to end the operation. See the figure below: 

 

As shown above, the starting point of the graph is a green dot, and the end point is a diamond dot. Here the 

initial curve/arc has been drawn. Move the mouse to the point and the cursor becomes the shape of ; 

hold down the left mouse button, move the mouse to the appropriate location, and then release the mouse 

to draw the required curve. You can also move the start or end point to the appropriate position. See the 

figure below: 

 

After completing the above steps, the transparency, line type, line width, line color, end point and endpoint 

shape of the curve / arc will be set by the system default. The engineer can modify these attributes to meet 

the requirement of engineering. Move the mouse to the curve/arc; double-click the left button, or select the 
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curve/arc first, and then click the toolbar property button , a dialog box same as that of Line Property 

will pop up. 

You can adjust the curve / arc properties through the pull-down and trimming buttons. The HMITOOL 

configuration software provides up to 15 line types, 10 kinds of line widths, and 6 straight-line end arrows 

for curves/arcs. 

 

4.3.4 Free line 

Select the Free Line command in the Draw menu or click the Free Line command button  in the 

toolbar. Move the mouse to the Edit window and the cursor will change to a cross shape so now you can 

draw a free line in the Edit window. 

Move the mouse to a position where you want to free line; click the left mouse button, and a small green dot 

will appear in the editing window, which is the starting position of the free line. 

Move the mouse to other positions in the screen, and then the system will automatically draw a free line 

following the trajectory of the mouse movement; click the left mouse button or right button to complete 

drawing the free line. See the figure below: 

 

After the above steps, the transparency, line type, line width, line color, end arrow and end point shape of 

the free curve will be set by the system default. The engineer can modify these attributes to meet the needs 

of the project: Move the cursor to the free curve, double-click the left button; or select the free curve first, 

and then click the toolbar property button , a dialog box same as that of Line Property will pop up. 

In this case, you can adjust the properties of the free curve through the pull-down and fine-tune buttons. 

The HMITOOL configuration software provides up to 6 straight line types, 30 kinds of line width and 6 types 

of straight-line end arrows for curves/arcs. 

4.3.5 Rectangle 

Select the Rectangle command in the Draw menu or click the Rectangle command button  in the 

toolbar button. Move the mouse to the Edit window and then the cursor will change to a cross; click on the 

screen to add a rectangle. 

To change the size of the rectangle, select the rectangle first, and then move the mouse to the eight square 

green dots which appear in the rectangle. When the mouse cursor becomes  or  or  , click and 

hold down the left mouse button to drag the rectangle; release the left mouse button when it reaches the 

appropriate location. By now a required rectangular box is drawn. 

: Change the width of the rectangle 
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: Change the height of the rectangle 

: Change the width and height of the rectangle 

After the above steps, the transparency, line type, line width, line color and fill pattern of the rectangle will 

be set by the system default. The engineer can modify these properties to meet the needs of the project. 

Move the mouse to the rectangle, double click the left button; or select the rectangle first, and then click the 

Property button  in the toolbar. The properties of the rectangle will pop up, as shown in figure below: 

 

You can adjust the properties of the rectangle through the pull-down and fine-tune buttons. HMITOOL 

configuration software provides up to 15 types of borderline, 10 kinds of borderline width and 21 kinds of fill 

patterns. See the figure below: 

 

4.3.6 Rounded rectangle 

Choose the  icon from Basic Graphs in the control bar, move the cursor to editing area, and the cursor 

will become a cross. 

Click the starting position where the graph will be placed, drag the cursor when pressing the mouse key. At 

this moment the system will automatically draw an area along the track of the cursor. Then, click left or right 

mouse key to complete drawing of rectangle. 

To change the size of the rounded rectangle, select the rectangle first, and then move the mouse to the eight 

square green dots which appear in the rectangle. When the mouse cursor becomes  or  or  , 

click and hold down the left mouse button to drag the rounded rectangle; release the left mouse button 

when it reaches the appropriate location. By now a required rounded rectangular box is drawn. 
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: Change the width of the rounded rectangle 

: Change the height of the rounded rectangle 

: Change the width and height of the rounded rectangle 

After the above steps, the transparency, line type, line width, line color and fill pattern of the rounded 

rectangle will be set by the system default. The engineer can modify these properties to meet the needs of 

the project. Move the mouse on it, double click the left button; or select the rounded rectangle first, and 

then click the Property button  in the toolbar. The properties of the rectangle will pop up, as shown in 

figure below: 

 

Radius of X curve: Radian of the four corners in X direction. 

Radius of Y curve: Radian of the four corners in Y direction. 

4.3.7 Circle/Ellipse 

Select the Circle/Ellipse command in the Draw menu or left-click the Circle/Ellipse command button  

in the toolbar. Move the mouse to the screen editing window, and the mouse cursor will become a cross; 

click the left mouse button on the screen to add a circle to the screen. 

To change the size of an ellipse / circle, select the Circle/Ellipse first, and then move the mouse to the 8 

square green dots that appear in the ellipse / circle. When the mouse cursor becomes  or  or , 

click and hold down the left mouse button to an appropriate location; release the left button to complete 
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drawing. 

: Change the width of the ellipse / circle 

: Change the height of the ellipse / circle 

: Change the width and height of the ellipse / circle 

After the above steps, the transparency, line type, line width, line color, and fill pattern of the ellipse / circle 

will be set by default. The engineer can modify these attributes to meet the needs of the project. Move the 

cursor to the ellipse / circle, double click the left button; or select the Circle/Ellipse first, and then click the 

Property button  in the toolbar, here a dialog box will pop up. 

The HMITOOL configuration software provides up to 15 types of border line, 10 kinds of border line width 

and 21 of fill patterns for ellipse / circle. See the figure below: 

 

4.3.8 Polygon 

Select the Polygon command in the Draw menu or click the Polygon command button  in the toolbar. 

Move the mouse to the editing window. The mouse will change to a cross, by now you can draw a polygon in 

the screen. 

Move the mouse to a position where you want to draw a polygon, left click (or hold down the left button), 

then a small green dot will appear in the screen editing window, which is the start point of the polygon. 

Move the mouse to another position on the screen. At this time, the system will draw a straight line 

automatically. Move the mouse to other appropriate positions; each time you left click, a new side of 

polygon is drawn; right click to complete drawing. See the figure below: 

 

To re-shape a polygon, click it first and it will appear several green dots (depending on the number of sides 

of the polygon), indicating that the polygon has been selected; and then move the mouse cursor over one of 

them, then it will become the shape ; left click and drag it to the position you prefer, so that you can 

change the length and location of two lines connected by this turning point. Release the left button to 
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complete. 

After the above steps, the transparency, line type, line width, line color and fill pattern of the polygon will be 

set by the system default. The engineer can modify these attributes to meet the needs of the project. Move 

the mouse over the polygon, double click the left mouse button; or select the polygon first, and then click 

the Property button  in the toolbar, and a dialog box same as that of the rectangle will pop up. 

You can adjust the properties of polygon through the pull-down and fine-tuning buttons. HMITOOL 

configuration software provides up to 15 types of border line, 10 kinds of border line width and 21 kinds of 

fill patterns for the polygon, as shown in figure below: 

 

4.3.9 Sector 

Select the Sector command in the Draw menu or left-click the Sector command button  in the toolbar; 

move the mouse to the screen editing window, and then it will become a cross, which means you can draw a 

pie chart in the screen now. See the figure below: 

 

Move the mouse to any point of the green dots in the middle of the rectangle, then the mouse will change to 

the shape ; change the arc of the sector by moving the mouse. 

4.3.10 Text 

Select the Text command in the Draw menu or left-click the Text command button  in the toolbar to 

bring up the Static Text dialog box, as shown in figure below: 
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Input the text to be displayed in TEXT in the dialog box above. 

The size of the font to be displayed can be changed in the drop-down menu of Font Size. HMITOOL 

configuration software provides the font size of 7-56 pound. 

Engineering designers can change the types of fonts to be displayed in the drop-down menu of Font. 

HMITOOL configuration software provides almost all font styles. 

Language: For different languages, you can enter different text contents in the text box, different font and 

font size are also available. 

In the dialog box, click the left button before the Bold and Italic box to change the fond. 

The configuration software provides kerning and line spacing that vary from 0-15 through the fine-tuning 

button next to the kerning and line spacing. 

HMITOOL configuration software also provides up to 16 kinds of underline form, and can change the display 

position of text contents in the text box; you can also change the fill pattern and transparency. 

When the font property is modified, click "OK" to close the dialog box. Move the mouse to where you want to 

place the text in the editing window; left click the left mouse button, and the system will draw a rectangle 

automatically. 

To modify or re-input the text contents, double-click the text unit with the left mouse button, then re-enter 

the contents through the keyboard. You can use the Enter to change line feed when using the keyboard. 

To change the size of the text background box, select the text unit, and then move the mouse to its edge; 

when the mouse becomes or  or , click and hold down the left mouse button to pull the text 

box to the appropriate location; after that release the left mouse button to complete the operation. 

: Change the width of the text unit background 

: Change the height of the text unit background 

: Change the width and height of the text unit 



HMITOOL Configuration Software Application Manual HMITOOL configuration guidelines 

202501(V1.0) 73 

4.3.11 Table 

Select the Table command in the Draw menu or the left click the command button  in the toolbar, 

then it will appear a pop-up table dialog box, as shown in figure below: 

 

In the above dialog box of the above diagram, HMITOOL configuration software provides choices of the 

Background Color, Border, Grid and Grid lines. You can decide whether to display vertical or horizontal grid 

lines in the Grid option, and the type and color of lines are changeable. 

The table is just a graphic object, which means you cannot add text, data or other embedded objects to the 

table. The table can only be displayed as a chassis image. To display text, data, and other objects on a table, 

you can use Text and numeric display objects to overlay the table and set it to the top layer. 

4.3.12 Scale 

Select the Table command in the Draw menu or the left click mouse the command button  in the 

toolbar, then it will appear a pop-up scale dialog box, as shown in figure below: 
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In the above dialog box, HMITOOL configuration software provides choices of Color, Axis and Text. The color 

item allows to selecting the line color and text color. You can select whether to display the axes in the Axis 

item and decide the number of the major scale and sub scale by means of the trimming button or inputting 

directly. Decide whether to display text in the text item and change the maximum and minimum values of 

the scale, as well as the size of the text and the decimal digits of the scale value. 

When you have modified the scale property and click "OK" to close the dialog box, move the mouse to the 

position where you want to display the scale. Click the left mouse button, and then the system will 

automatically draw a scale unit. See the figure below: 

 

After the above steps, a scale like first from left of the figure above. If you want to change it to the form of the 
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second left scale in the figure above, first choose the scale, move the mouse to one of the height sides, press 

down the left key and drag the mouse when the mouse becomes , and have the mouse pass through the 

other height side. To change the scale to the right forms in the figure above, perform Free Rotation for it. 

4.3.13 Open library 

Select the Open Library command in the Draw menu or click the Open Library command button  in 

the toolbar to bring up the Library List dialog box, as shown in figure below: 

 

The system library of HMITOOL configuration editing software provides a wealth of graphic objects for 

engineering designers. HMITOOL version is even added a large number of buttons, indicators and other 

graphic objects. Engineering designers can find a proper graphic object so as to save configuration design 

time. 

Engineers only need to click on the category of the desired graphic object in the system library on the left. 

Click the + sign to open the sub-category, and then select the desired graphic. Click to select the image, and 

then click on the screen to add graphic object when the cursor become a cross.  

Modify: After selecting the graphic you want to modify, click the "Modify" button at the bottom left of the 

dialog box, as shown in figure below: 
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In the interface shown as figure above, select the graphic, and then execute the "Split" function on the tool 

bar to split the control. Then you can choose one part to modify: settings of foreground color, background 

color, pattern and others can be found on the right of the dialog box. After modification, execute the Group 

command to the entire split graphics, and then click the "Save". 

 

In the "Custom" list on the left of the dialog box, select the location where you want to save the modified 

graphics (e.g. "Library 2") and click "Save". If you want to view the newly saved graphics, click the Open Lib 
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command button  in the pop-up dialog box, then select the "Custom Library". 

4.3.14 External picture 

In HMITOOL, pictures can be inserted into a number of controls; take the "Static Picture" as an example: 

 

Picture:  

Library: Built-in gallery in the system, as shown below: 
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File: Consist of External File and System File. External pictures can be those in computer and system pictures 

are available for downloading on the official website, which will be saved in the folder of Extern_Pic under 

the installation directory. 

When "System" is selected, the following dialog box will pop up: 

 

These images are stored in the Extern_Pic folder under the installation directory, as shown below: 

 

The Extern_Pic folder contains two folders: the share_picture folder and system_picture folder, 

corresponding respectively to the shared picture and system picture in the Gallery image list, of which those 

in the system_picture folder are system pictures that cannot be added or modified, while those in the 
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share_picture folder can, as shown in the following figure: 

 

You can add other folders by yourself in the share_picture folder or change the name of an existing folder 

(for example, Motor), meanwhile the name of share_picture folder cannot be changed. In addition, it is 

possible to add or delete pictures of the Motor folder. 

4.3.15 Regular polygon 

Select the straight line command in the drawing menu or the left mouse button to click the regular polygon 

command button  in the toolbox button to set the number of corners, transparency, line type, line 

width, line color of the regular polygon to meet the needs of the project. After setting, click the button to 

determine the button, the screen appears cross mark, move to the appropriate position of the screen, click 

the left, you can draw a regular polygon. You can click the right polygon control through the left mouse 

button, right-click the "property" or click the toolbar button , set the property, modify the regular 

polygon. 
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The size of the control can be freely stretched by controlling the green dots around it. 

4.4 HMITOOL basic controls 

This chapter mainly introduces the use of basic controls of HMITOOL. 

4.4.1 Bit button 

Bit button is used to operate and display the ON/OFF status or 1/0 status of the bit address of the device 

connected with the HMI. Bit button is the most fundamental and frequently used control. Steps to set a Bit 

button: 

1. Click the Bit Button icon  on the toolbar to bring up a dialog box, which is for setting the properties 

of Bit Button, as shown in figure below: 
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2. The dialog box includes four items, that is, "General", "Mark", "Advanced" and "Visibility". 

Â General 

Shape: Click the Shape button to select a shape for the control graph, as shown in figure below. 

 

¸ Border Color: When having chosen a shape with border, click this button to select a different color for the 

border. 

¸ Foreground Color: When it needs to change the foreground color, click this button to choose a different 

foreground color on the drop-down color selection box. (Foreground color works only if the transition 

style is selected). 

¸ Background Color: When it needs to change the background color, click the button to select on the 

drop-down color selection box. 

¸ Pattern: Click the drop-down box, which contains a total of 21 kinds of patterns as shown in figure below: 
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¸ Set: If Set function is chosen, after the downloading to HMI, the value of the write-in address may be set 

to 1 by clicking the bit button. In other words, the write-in address of the device connected will be set to 

ON status, and the status of 1/ON will be displayed. 

¸ Reset: If Reset function is chosen, after downloading to HMI, the value of the write-in address may be set 

to 0 by clicking the bit button. In other words, the write-in address of the device connected will be set to 

OFF status, and the status of 0/OFF will be displayed. 

¸ Inching: If Inching function is chosen, either "pressing down being 1" or "pressing down being 0" may be 

chosen. When "pressing down being 1" is chosen, after downloading to HMI, the value of the write-in 

address of the device connected is set to 1/ON when the bit button is pressed down, and the status of 

1/ON will be displayed; meanwhile, the value of the write-in address of the device connected is set to 

0/OFF when the bit button is released, and the status of 0/OFF will be displayed. When "pressing down 

being 0" is chosen, after download to HMI, the value of the write-in address of the device connected is set 

to 0/OFF when the bit button is pressed down, and the status of 0/OFF will be displayed; Meanwhile, the 

value of the write-in address of the device connected is set to 1/ON when the bit button is released, and 

the status of 1/ON will be displayed. 

¸ Alternate: When alternate function is chosen, after the downloading to HMI, if the current status of the bit 

button is 0/OFF, the value of the write-in address will be set to 1/ON when the bit button is touched, and 

the status of 1/ON will be displayed; If the current status of the bit button is 1/ON, the value of the 

write-in address will be set to 0/OFF when the bit button is touched, and the status of 0/OFF will be 

displayed. The status changes with the times of touching. 

¸ Write Address: Click the Keyboard button icon after "Write Address" to enter the address. HMITOOL 

software will distribute corresponding address symbols according to different connected devices. For 

example, in FX-2N series of MITSUBISHI (Mitsubishi) PLC, X represents the address of input coil; Y 

represents that of the output coil; M that of the intermediate relay; C that of the counter (switch status 

display); T that of the timer (switch Status display); D that of the data register; C * that of the counter 

(count value); T * represents that of the timer (count value). Another example is the series of SIEMENS 
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(Siemens) S7-200: I represents the input address; Q on behalf of the output address; M on behalf of the 

intermediate relay address; V on behalf of the data register address. See the figure below: 

 

So that engineers can write the current status of this bit button to the address using a different address 

symbol for PLC or other connected devices. The value of the write address or display address is 0 / OFF when 

the bit button is in the 0 / OFF state; and the value of the write or display address is 1 / ON when the control 

is in the state of 1 / ON. 

¸ Monitor: Select "Monitor" to display the "Monitor Address", indicating that the "bit button" can be used 

to monitor the value change of "Monitor Address". The value of the Monitor address is 0 / OFF when the 

bit button is in the 0 / OFF state; and the value of the Monitor address is 1 / ON when the control is in the 

state of 1 / ON. When "Monitor Address" is chosen, the monitor address and write address can be 

different. For example, when it selects the Set function, touching this control makes set the write address 

to 1 / ON; but if the monitor address is at 0 / OFF at this time, the bit button will still display 0 /OFF state. 

Generally, users choose "Monitor address identical to Write address" in order to reflect or display directly 

the state value you write. 

¸ Macro: Chosen "Use Macro", then it will display a list of macros. User can select a macro to execute when 

press the bit button. Only compiled macros are displayed in the drop-down list. 

Note: When Monitor isn't chosen, the button switch state will not change even if the control is touched. 

Â Mark:  

When select the Mark tab, the property of Status 0 Text is displayed, as shown in figure below: 
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The page also has four items, "Status 0 Text", "Status 1 Text", "Status 0 Picture" and "Status 1 Picture". 

Status 0 Text, Status 1 Text: Used to change the font, font size, margin, font color, and position of the state 0 

or state 1 text. HMITOOL also provides the copying function, enabling copy one's attributes to another's, 

which is convenient and timesaving. 

¸ All Texts use the first language: This option is used when it comes to multiple languages ("Language" in 

the Project Manager). When the total number of languages is greater than 1, you can select this option to 

make sure that the contents of this control will not switch with the languages. 

¸ Language: This option is used when it comes to multiple languages. Input contents with a different 

language for multiple languages.(In the Function button, select the 'Switch language' option and which 

one to switch to; then in the simulation or on the HMI screen, all the controls with text will be presented 

by the selected language). For different languages, the text content, font and font size can be different, 

but the color, kerning and position are the same. 

¸ Font: Choose the type of text for the text; different languages can choose different fonts. 

¸ Font Size: Choose the font size for the text content; different languages can choose different font sizes. 

¸ Color, Margin, Position: Set the color, Margin, and alignment of the text selected current. When it has 

more than one language, these options are the same to that of the language 1, and they are invalid in the 

language setting of others. 

¸ Status 0 Picture, Status 1 Picture: You can add different formats of picture for different states according 

to various "Picture source". When a picture is chosen, it will be automatically added to the "General" 

page. If "Fit to Object Size" is selected, the selected image will be the same size as the control. 

¸ Fit to Object Size: If "Fit to Object Size" is selected, the selected image will be the same size as the control; 

and the Margin and Position options are hidden. 

If you import a picture from an external file, the "Transparency" option appears to make a specified color 

transparent 

Note: When "Flicker" is chosen, the flashing screen is on the ON / OFF status. The default flashing 
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frequency is 1s. If you want to change the frequency, you can double-click the "Project Manager" in the "HMI 

parameter settings". Select the "Flashing frequency" to change it. 

Â Advanced 

Select the "Advanced" page to display the "Advanced" properties, as shown in figure below: 

 

¸ Controlled by Bit: "Controlled by Bit" having been chosen, when the "Valid Status" selected is 1, the "Bit 

Button" can be effectively touched if and only if the value of the "Control Bit" is 1. When the selected 

"Valid Status" is 0, the "Bit Button" can only be effective if and only if the value of the "Control Bit" is set 

to 0. Otherwise, the "Bit Button" cannot function no matter how. 

¸ Controlled by User Level: User can select multiple options as needed. After setting, in the simulation or 

on the HMI screen, the current user is checked whether this user lever has the permission. 

For example, if option 2 and 3 are chosen in the Effective Level Controlled in the Advanced Page of the 

control, and the User Password Setting in the HMI Parameter Setting is as shown in figure below:  
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If Default User Level is NULL, this control is not touchable, and in this case you can use Change User Level in 

Function buttons to change the default level. For example, if the password entered by the user is 6666, 

corresponding to User Level 6, but the user chooses only option 1, not matching option 2 or 3, so the system 

will prompt that the password is incorrect; When the password entered by the user is 2222 or 3333, as both 

users have option 2, matching option 2 or 3, the password is valid and this control will be changed to a 

touchable control. If the Default User Level is user 2 to 3, then both user levels have option 2 to match the 

touching conditions, and then this control is touchable in simulation or initialized screen; If the Default User 

Level is user 6, then this user level does not have an option to match the touching conditions, and then this 

control is not touchable in simulation or initialized screen. The default setting is as shown in figure below: 

 

If select "change the user level is insufficient", when the user level is not matched, a login interface will pop 

up so that user can select a matching level and log in again, as shown below: 

 

In HMITOOL software, only bit button, drop-down box, ASCII input, function button, ASCII keyboard input, 

multi-function button, multi-state button, recipe selection, screen button, radio button, step button, word 
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button, slider and numeric input controls have this function, and as for their application, it can refer to that 

of bit button. 

¸ Minimum press time: How many seconds it needs to react after the press in the simulation or on the HMI 

screen. 

¸ Notification: In the case of that the control can be touched in the simulation or on the HMI screen, click 

on the control, and enter a value with the pop-up input keyboard; then the state value will be written to 

the set "Notification Bit" address (1 or 0). 

¸ Notification Register: In the case of that the control can be touched in the simulation or on HMI screen, 

click on the control, and input a value through the pop-up input keyboard, then the value will be written 

to the set "notification register address" ( i.e. the value input by user). 

¸ Hotkey: When this function is selected, you can enter a number or character to achieve the same effect as 

that of pressing, For example, if input 1, click the numeric keypad 1in the simulation or on HMI screen, or 

through an external keyboard, it functions similarly. 

 

Note: The default user level is NULL, which is the lowest level. Engineering designers can change it by 

selecting the "Change User Level" function in the function button and entering the corresponding password. 

Effective touch means actual effect generates when the control is touched, such as the success of the set, 

reset, inching, alternation. Another example is the numeric input. When user touches the numeric input 

button, the keyboard will pop up. Meanwhile the numeric input button will not generate a notification effect, 

since this operation is not written to the address. If you press ESC to exit the keyboard will not produce 

notice. 

It is valid only when you enter a numeric value between the maximum and minimum values on the keyboard 

and press the ENTER key, then a notification will arise. 

Â Visibility 

Select the "Visibility" page to display the "Visibility" property, which is used to set whether the control is 

displayed or hidden. See the figure below: 
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¸ Controlled by bit: When this option is checked, if the Effective State is 1, then the Bit Button can be 

displayed on the HMI when and only when the value of the Control Bit is 1; If the Effective State is 0, then 

the Bit Button can be displayed on the HMI when and only when the value of the Control Bit is 0. 

¸ Controlled by User Level: When User Level Controlled is chosen, the conditions will be the same as those 

in the User Level Controlled option in "Advanced" page, and only when such conditions are met the Bit 

Button can be displayed on the HMI. 

¸ Word control: Set the judgment condition, and when the register address data satisfies the setting 

condition, the control displays, otherwise the control is hidden 

Note: If neither of these two options is checked, the control will be always displayed on the HMI. 

4.4.2 Word button 

Word Button can support operations of Constant, Enter Value, Increasing, Decreasing, Enter Password, Add 

and Subtract to the data register address of connected device.  

To add a word button: 

Select the Word Button icon  on the toolbar, then the following dialog box is displayed, as shown in 

figure below: 

 

Note: The shape, border color, foreground color, background color and pattern can be set with reference 

to "Bit Button" control. 

Function:  

¸ Set constant: You can choose different data types, HMITOOL software provides a variety of data types: 

16/32-bit positive integer, 16/32-bit integer, 16/32-bit BCD positive integer and 32-bit floating point 

number. Setting a constant is to write the constant value you set to the write address. For example, if the 

write address is LW1 and the constant is set to 10, the value of LW1 is set to 10 every time the button is 

touched, regardless of its current value. 

¸ Enter value: You can select a different data type; input a value between the maximum and minimum with 
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a keyboard popping up after the word button being touched. See the figure below: 

 

¸ Increasing: When the Delay parameter is 0, its function is the same as that of the Add. If the Delay 

parameter is not 0, the value of the write address increases by a constant value and is written to the 

register. 

¸ Decreasing: When "Delay parameter" is 0, this function is the same as that of "Subtract". If "Delay 

parameter" is not 0, after a certain time, the value written to the address decreases by the constant value 

and is written to the register. 

¸ Enter Password: Same as the "Enter Value" except that the "Enter Password" function has no option of 

decimal digits. 

¸ Add: After choosing the data type, writing the address, constant and maximum value, every time you 

touch the "word button" control, the set value corresponding to the register value will plus the constant 

value based on the original value. Each time the button is touched, the value written to the address is 

incremented by a constant; however the value written to the address cannot exceed the maximum value 

you set. For example, the write address is LW1, the constant is 5, and the maximum value is 65535. Each 

time you click the Word Button control, the value of LW1 is added to the original value by 5, but the 

maximum value of LW1 cannot exceed 65535. 

¸ Subtract: After choosing the data type, writing the address, constant and minimum value, every time you 

touch the "word button" control, the set value corresponding to the register value will minus the 

constant value based on the original value. Each time the button is touched, the value written to the 

address is decremented by a constant; however the value written to the address cannot be less than the 

maximum value you set. For example, the write address is LW1, the constant is 5, and the minimum value 

is 0. Each time you click the Word Button control, the value of LW1 is subtracted from the original value 

by 5, but the value of LW1 cannot be less than 0. 

¸ Total number of digits: Number of data including that of decimal points. 

¸ Decimal digits: When the data type is not "32-bit floating point" and there are decimal digits, then the 

maximum value of the input value should be reduced to 10 nth power. For example: When the selected 

data type is "32-bit positive integer", and the number of digits is 3, so the user can only enter the value of 

0-99999.999. 

¸ Macro: When "Use Macro" is chosen, the macro list is displayed. The user can select a macro to execute 
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when the word button is pressed. Only compiled macros are displayed in the drop-down list. 

Note: The "Mark" tab of the "Word Button" is similar to that of the "Bit Button" control, except that the 

Word button has neither Status Text 1 nor Status Picture 1 because the Word Button has only one state. 

If select the 32-bit data type for Word button, the address will occupy the length of two words. For example, 

write V10 to SIEMENS (Siemens) PLC data register, then the occupied data register address includes V10 and 

V11. If user still employs other control to monitor V11 value, it will fail to work. Pay attention to the 

application of 32-bit data type in case of error. 

The "Advanced" and "Visibility" pages of the Word Button are the same as that of the Bit Button control. You 

can refer to the Bit Button control and refer to Bit Switch for the use of hotkey. 

4.4.3 Bit lamp 

The Bit Lamp can be used to monitor the ON / OFF status of bit contact of the connected device and to 

display it on the HMI scree. See the figure below: 

 

Set up a Bit Lamp: 

1. Select the Bit Lamp button icon  on the toolbar: The dialog box shown in figure below will pop up: 

 

¸ Data Type: The drop-down box has three options, namely: Bit, Word Bit and Double-word Bit. If you 
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select "Bit", the Monitor (read) address is Double-word Bit means a double word address. 

¸ Bit Number: When the chosen data type is "Word Bit" or "Double-word Bit", the value of the monitor 

address (status of ON/OFF) is determined by the bit number value. It is from 0 to 15 for Word Bit and 0 to 

31 for Double-word Bit. 

For example, when "Word Bit" is selected, the monitor address is LW1 with a value of 23, if the bit 

number is 3, the state of this address value is 0 because the binary number of 23 is 10111 whose 3rd 

number from right to left is 0.  

Note: Refer to Bit Button control for Shape, Border color, Foreground color, Background color and 

Pattern. 

2. In the "General" property dialog box of the bit lamp, choose an address to be monitored by this indicator. 

Through the settings in "Mark", you can set contents and pictures to be displayed and also choose whether 

to blink. 

Note: The "Mark" page of the "Bit Lamp" is the same as that of the "Bit Button" which you can refer to. 

To reset the properties of this indicator, double-click it to reset it in the property dialog box. 

Note: The "Visibility" page of the Bit Lamp is the same as that of the Bit Button control that you can refer 

to. 

3. After the properties set up, click "OK" to add the control in the view area (i.e., the screen) 

4.4.4 Multi-state indicator lamp 

The Multi-state indicator lamp control is mainly used to display different states according to the value of the 

monitor address. Up to 512 states can be displayed. 

Click the Multi-state indicator button  on the toolbar to bring up the dialog box as shown in figure 

below: 

 

Â General:  
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¸ State: User can change the status value in order to modify the border color, foreground color, 

background color and pattern of the control in different states 

¸ State Type: (Assuming the user input value is n) 

¸ Value: the written value is from zero to the number of total states minus 1. 

¸ Register Bit: The written value is the n power of 2. 

For example: 

The monitor (read) address is LW3, and then the total state number is 8. After, click "OK" to add the control 

to the screen; then add a numerical input control on the screen; set the write address and monitor address 

to LW3; finally save the project. 

In the simulation or on the screen, user clicks on the numeric input control, and input a preferred state value 

through the input keyboard. If the input value is 2, the value of the monitoring (reading) address is 1, the 

control shows the text in the state of 1 (the text content in state 1 of the control in the Text page); 

correspondingly, when the value entered for the LW3 address is 8, the control will display the text content of 

state 3. If a value of 3 is input to the LW3 address, the multi-state indicator does not switch to any state. 

¸ Customize status value: When user selects this option, a "Defined status value" button appears. Click it to 

bring up "Customize status value" dialog interface, as shown in figure below: 

 

In this dialog box, the "S #" column is the current status column, that is, the selected value in it indicates the 

current status value; double- click a Value to enter the value in the current state that you want to write. 

For example: The monitor (read) address is LW3, and then the total state number is 8. After, click "OK" to 

add the control to the screen; then add a numerical input control on the screen; set the write address and 

monitor address to LW3; finally save the project. 

In the simulation or on the screen, user clicks on the numeric input control, and input a preferred state value 

through the input keyboard. If the input value is 1, the value of the monitoring (reading) address is 1, the 

control shows the text in the state of 1 (the text content in state 1 of the control in the Text page); 

correspondingly, when the value entered for the LW3 address is 33, the control will display the text content 

of state 33. If a value of 513 is input to the LW3 address, the multi-state indicator does not switch to any 
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state. 

¸ Data Type: The data type of the write address and monitor (read) address. 

¸ Monitor address: The read address, which is a status value to be read, and then reflects the current state 

selected by user in the control. 

¸ Total states: Users can set the total number of states according to individual need, which can be up to 

512 states, that is from state 0 to state 511. 

For example, selecting a data type of 16-bit positive integer, a total number of states of 512, when the data 

value stored in the monitor address is 0, the Multi-state indicator shows the text and the corresponding 

picture of the state 0; if the data value is 5, the Multi-state indicator will show the text and the corresponding 

picture of the state 5;. When the value is 516, the Multi-state indicator will not display the message of the 

State, because the total number of states up to 512 states. 

Note:   

Õ Shape, Border color, Foreground color, Background color and Pattern can be used with reference to that 

of "Bit Button" control. 

Õ When "Multi-state indicator lamp" selects the 32-bit data type, the stored address occupies 2 words. For 

example, when write data to the SIEMENS PLC's data register, and the address written is V10 , then the 

occupied data register address includes V10 and V11; if users also use other controls to monitor the value 

of V11, an error will appear. Users should pay attention to the use of 32-bit data types in case of Note 

data and address errors.  

Õ The data category must be consistent with the data to be indicated. 

Â Text:  

Click the "Text" tab of the Multi-State Indicator Property box to display the text property settings screen as 

shown in figure below: 

 

¸ All languages use the first language text: This option is employed when dealing with multiple languages, 

that is, in the "Language" in the Project Manager, the total number of languages selected is greater than 
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1; in this case, the control text does not change with the switch of language. 

¸ Language: This option is used when dealing with multiple languages. Select a different language, you can 

enter different text contents in different states, in order to achieve the multi-language. (In the function 

button, select the 'Switch language' option, and the language to switch to; in the simulation or screen, 

click this button, and then all the screen with text control will switch to that with text content of the 

specified language). For different languages, text content, font and font size can be different, but the 

color, kerning and position are the same. 

¸ Font: You can choose the type of text for the input text; different states can choose different fonts, and 

different languages can choose different fonts. 

¸ Font Size: You can choose the font size for the input text content; different states can choose different 

font sizes; different languages can also choose different font sizes. 

¸ Color, Kerning, Position: Set the color, kerning, and alignment of the selected text. When you choose a 

language other than Language 1 in the Text page when the total number of languages selected in the 

Project Manager is greater than 1, the three functions: color, kerning and position are invalid because 

they are the same as the language 1. 

Â Picture:  

Click the "Picture" tab of the Multi-State Indicator Property box to display the attribute settings as shown in 

figure below. 

 

This page is mainly employed to load pictures for different states. Picture of each state is empty by default 

while it can be changed according to personal need. 

Steps are as follows: Select the item in the list box whose picture needs to be changed, then choose the right 

picture either in system library or through save path on Windows. So when click on different status, 

corresponding pictures will be loaded below. In addition, user can also decide whether to fit to Object: if not, 
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the margin and position of the control can also be modified, so as to beautify it. 

Fit to Object: When this is selected, the size of the graphic is the same as that of the controls on the General 

page while the Margin and Position options are hidden, otherwise they appear.  

If importing a picture from an external file, the "Transparent" option will display for use. This function is 

meant to make a specified color transparent. 

Note: Refer to "Bit button" control for Visibility page. 

After setting all the properties, click "OK" and then add the control in the screen area. 

4.4.5 Screen button 

Screen button is designed for screen switching, changing the user level, pop-up window and other 

operations. After being set, it can make a screen/ window jump to a certain screen / window while you can 

also decide whether to change the user level at the same time. 

Click the icon button  on the toolbar to bring up the dialog box, as shown in figure below: 

 

Note: Shape, border color, foreground color, background color and pattern settings can be used with 

reference to "Bit Button". 

Â Function modules: 

Open Screen: It allows users to jump to the selected screen by clicking the button. This function can be 

employed on a screen or in a window. 

Open Previous Screen: It allows users to jump to the previous screen of this page by clicking the button.  

This function can only be used in the screen page. 

Close Open Screen: This function can only be used in the window page. It allows closing the current window 

and opening another window or screening. 

Close Screen: This function can only be used in the window page. This function allows closing the current 

window page. 
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Â Switch user level: 

Logout: Restore the current user level to the default user level 

Specified User Level: Change the current user level to the specified user level 

Â Open function: 

Press: When the user presses the mouse, it executes the screen switching function. 

Release: When the user releases the mouse, it executes the screen switching function. 

Â Login required if level is insufficient: 

If the user has selected the "Controlled by User Level" option on the "Advanced" page of the "Screen 

Button" dialog box, and has changed the "Effective Lowest Level", then the screen control is only valid if the 

current user level is higher than or equal to the user- If the current user level is less than the effective 

minimum level set by the user, the password input box will pop up when the user touches the screen control 

on the HMI, as shown in figure below: 

 

This screen can only be opened when the password entered by the user is higher than that set by the user, 

and the current user level is decided by the level password just entered by the user. 

Â Macros: 

"Open macros" displays a list of macros. The user can select one to execute when press the button. Only 

compiled macros can be displayed in the drop-down list. 

Note: The "Label" page of the Screen Button is similar to that of the "Bit Button" control. Because the 

Screen Button has only one state, its Label page only has Status 1 Text and Status 1 Picture. Apart from that, 

the functions are the same. 

The "Advanced" and "Visibility" pages of the "Screen Buttons" are the same as those of the "Bit Button" 

control, which can be used with reference to the Bit Button. 

After setting all the properties, click "OK" and the mouse cursor will turn into a cross. Left click in the view 

area to add the control to the screen. 
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4.4.6 Function button 

Function Button is an essential control in HMI; with the Function button you can achieve a variety of 

functions easily and quickly. Click  to open the property dialog box of Function Button, as shown in 

figure below:  

 

 

Note: Refer to Bit Button control for Shape, Border color, Foreground color, Background color and 

Pattern. 

1. Turn off Background light 

Choose the function of turn off the background light. Then click the button on the screen to turn off it while 

HMI will still works properly. To turn on the backlight, simply touch anywhere on the HMI. 

2. Confirm Alarm 

Choose the function of Confirm the alarm. Then you can confirm the selected alarm by clicking the button. 

3. Restart 

If the function button is set to System Restart, then the HMI will be restarted by touching this button. 

4. Set screen saver timeout 

If the function button is set to Set Screen Saver Timeout, then a window will pop up for setting of screen 

saver timeout after touching this button. 

5. Write recipe to the PLC 

Choose this function to transmit recipe to the PLC. Click this button on the HMI to transmit the recipe saved 

in the current HMI to the PLC or corresponding continuous data register of other connected devices. (The 

address is the write address set by engineers when set up a recipe with the software.) 

6. Read recipe from the PLC 

Choose this function to read recipe from the PLC. Click this button on the HMI to read the recipe data from 

the PLC or corresponding continuous data register of other connected devices. (The address is the write 
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address set by engineers when set up a recipe with the software.) 

7. Set the date and time  

Choose this function to set the time and date; click the button on the HMI to set the inner time and date. 

8. Clear Alarm 

Choose this function to clear the alarm; click the button on the HMI to clear the selected and confirmed 

alarm. 

9. Previous recipe 

Choose this function of the Previous Recipe to open the previous recipe of the current one after clicking this 

button. If the current recipe is the first one or the total number of recipe is 1, this operation does not change 

recipe parameters. 

10. The latter recipe 

Choose this function of the Latter Recipe to open the latter recipe of the current one after clicking this 

button. If the current recipe is the last one or the total number of recipe is 1, this operation does not change 

recipe parameters. 

11. Save the current recipe 

Choose this function for saving the current recipe by clicking the button on the HMI to save the recipe data 

from corresponding continuous data register of the PLC or other connected device, which is set when 

engineers set up the recipe with the software. 

12. Screenshots 

Set the function button function as Screenshot; click this button to intercept the current screen as a picture 

saved in the user-specified location. The address of Picture name can be input using ASCII Input, the Picture 

name cannot consist of : # %&*-+<> etc. And the length of the name must be 20 or shorter than 20. 

13. System parameters 

Set the system parameter of the function button. Click it on HMI to open the system parameter setting 

screen where you can modify settings, such as system time, screen saver time, background light contrast 

and so on. 

14. Log on 

Choose the function of Log on. When the user clicks this button, a login interface will pop up. After choosing 

the User Name, a keyboard will pop up with which user inputs a password to achieve access permission. 

15. Cancel user login 

Choose the function of cancel a user's login; click this button on the HMI to log out and cancel the current 

user's privilege so that the user's level becomes the lowest. 

16. Alarm Sound (ON / OFF) 

Choose the function of Alarm Sound ON / OFF to make a sound when it occurs an alarm. You can set the 

function button to enable or disable this function. If the current state is on, the alarm sound will be shielded 

after user clicking this button, and vice versa 

17. Touch sound (ON / OFF) 
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Set the function button to Touch Sound Switch, and then the touch sound may be turned on/off by touching 

this button. If there is touch sound at present, the touch sound will be turned off after touching this button, 

and vice versa. 

18. Clear all historical data 

The history data stored in HMI will be cleared. 

19. Clear the historical alarm 

The history alarm saved in HMI is cleared. 

20. HMI protection unlock 

Enter the password to deactivate the HMI protection. 

21. Recipe Read & Save 

Read and save the recipe. 

22. Alternate function 

Only as back-up function, it does not perform any operation. 

23. Reload recipe 

Reload the recipe data in flash to the corresponding RWI address. 

24. Switch languages 

Switch text contents of all the controls to that of another specified language 

25. Print Screen via a serial printer 

Print the set screen through a serial printer. Connection setting of the printer driver is under the "HMI 

Parameter settings" -> "Printer and Download settings", in the left frame of the software interface. 

26. Slave device IP configuration 

This function requires the "Extended Mode" that can be set in the "Communication Port Property". The 

application of Ethernet communications for multi-machine needs to add a station number and the register 

address controlling the station number in front of the corresponding control. When the project in HMI is 

running, click on the function control, and the station number set by user will be shown in the " IP config 

"dialog box; then set the corresponding IP parameters of station number to achieve multi-machine Ethernet 

communication. 

27. Function set of DIP switch 1 and 3 

Functions of DIP switch 1 and 3 on the hardware when they are in ON state, mainly consisting of IP setting, 

system time setting and backlight parameters. After the setting, click "OK" to restart. 

28. HMI delay solution lock 

When HMI protects the -> advanced -> delay function, the button is needed to hit the button at the HMI, and 

the delay function will take effect 

29. Touch calibration 

Recalibrate current HMI coordinates 

Use Macro: Selecting "Use macro" will bring up a list of macros and users can choose one to execute when 

the function is executed. Only compiled macros are displayed in the drop-down list. 
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Note: 

Õ After jumping to the system screen, the system will close the current project; when return from the 

system screen, it will restart the project, and enter the start screen of project settings. 

Õ The "Mark" page of Function button is similar to that of the "Bit Button" control which you can refer to, 

except that the Mark page of Function button has neither Status Text 1 nor Status Picture 1 because it 

has only one state. 

Õ The Advanced and Visibility pages of the Function Button are the same as that of the Bit Button control. 

You can refer to the Bit Button control and refer to Bit Switch for the use of hotkey. 

Õ Operations of Previous recipe, later recipe, save recipe, read & save recipe are only valid to the current 

recipe group. If you still want to operate, set the LW61141 group then. 

Õ Clear history data means all historical data groups are cleared. 

After setting all the properties, click "OK" to add the control button to the view area (i.e., the screen) 

4.4.7 Multi-state button 

Functions between Multi-state button and Multi-state indicator lamp are basically the same, while the only 

difference is that multi-state button supports value input, rather than simple function of indicating. Specific 

operation is as follows: 

Click the button icon  on the toolbar to display the dialog box shown below. 

 

¸ State: User can change the state value, as well as the border color, foreground color, background color 

and pattern of the control in different states 

¸ State type: (assuming the input value is n) 

Õ Value: The value written is a number from zero to the total number of states. 

Õ Register bit: the value written is nth power of 2. 

For example:  
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Select "Value" for State Type, "Keyboard Input" for Mode and LW3 for Write Address and select the 

option of "Monitor Address Identical to Write Address", the total number of states 8. After that, click "OK" 

to add the control to the screen, then save the project. 

In the simulation or screen, click on the control, and then an input keyboard pops up where user can 

enter a state value. Assuming that the input value is 3, then the value written to the register LW3 is the 

3rd power of 2, which shows the text in the state 3 (the text in state 3 of this control in the Text page). 

Conversely, when the value entered for the LW3 address is 8, the control displays the text content of the 

state 3. When the value of the LW3 address input is 5, the control does not display any status. 

Õ Customize Status Value: When select this option, a "Define Status Value..." button appears, as 

shown in figure below: 

 

Click "Define status value..." button, it will pop up a "Customize status value" dialog interface, as shown 

in figure below:  
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In this dialog box, the "S #" column is the current status column. After selecting a row, the corresponding 

value to "S#" in that row indicates the current status value; double-click to enter the value in the current 

state. 

For example, select "Customize status value" for State Type, "Keyboard Input" for Mode, and LW3 for Write 

Address and select the option of "Monitor Address Identical to Write Address", the total number of states is 8. 

After that, click "OK" to add the control to the screen, then save the project. In the simulation or screen, click 

on the control, and then an input keyboard pops up where user can enter a state value. Assuming that the 

input value is 1, then the value written to the register LW3 is 22, which shows the text in the state 1 (the text 

in state 1 of this control in the Text page). Conversely, when the value entered for the LW3 address is 33, the 

control displays the text content of the state 2. When the value of the LW3 address input is 2, the control 

does not display any status. 

¸ Mode: Provide six function options: "Keyboard Input", "Output constant", "Increase", "Decrease", 

"Loopback increase" and "Loopback decrease". 

Õ Keyboard input: Three options in the "State Type" can be selected. In the simulation or screen, 

when click the control, it will pop up a keyboard for user to enter the value, as shown in figure 

below: 

 

Õ Output constant: Only the "Value" option can be selected among the three function options in the 

"State Type". After selecting this option, a "constant" box will show for constant setting. In the 

simulation or screen, if click on the control, the value written is the set constant value 

Õ Increase: Only the "Value" option can be selected among the three function options in the "State 

Type". In the simulation or screen, when click on the control, each click means the number of state 

plus 1; it stops increasing in case of beyond the total number of state. 

Õ Decrease: Only the "Value" option can be selected among the three function options in the "State 

Type". In the simulation or screen, when click on the control, each click means the number of state 

minus 1; it stops decreasing in case of beyond the total number of state. 

Õ Loopback increase: Only the "Value" option can be selected among the three function options in the 

"State Type". In the simulation or screen, when click on the control, each click means the number of 

state plus 1; it returns to state 0 if beyond the total number of state. 

Õ Loopback decrease: Only the "Value" option can be selected among the three function options in 
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the "State Type". In the simulation or screen, when click the control, each click means the number 

of state minus 1, it will return to the maximum state in case of beyond the total number of state. 

¸ Data Type: The data type of the write address and monitor (read) address 

¸ Monitor address: Read address whose value is to read the state value and reflect the current state on the 

control. 

¸ Total number of states: the maximum number of states 

¸ Use Macro: If this option is selected, when click on the control in the simulation or screen, the macro 

selected by the user is executed in this case. 

Note: 

Õ Shape, border color, foreground color, background color and pattern can be used with reference to "Bit 

button" control. 

Õ Refer to "Multi-state indicator lamp" control for "Text" and "Picture" pages. 

Õ The "Advanced" and "Appearance" pages are referred to the "Bit Button" control. Specific hot keys can 

be used to refer to the bit switch. 

After setting the properties, click "OK" to add the control in the view area (that is, the screen) 

4.4.8 Numerical display 

Numeric display control is a commonly used control displaying values in data register stored in PLC or other 

connected devices, such as speed, current, pressure and so on. 

Select the display icon  in the toolbar, and then the system will bring up a dialog box. See the figure 

below: 

 

In this dialog box, you can set the value saved in data register of PLC or other connected devices, such as the 

display digits, the decimal place, and font size, color, alignment and adjustment of text control. 

¸ Data type: Users can choose different data categories according to the value of the register address to be 

monitored. 

¸ Display Type: Users can choose different display categories according to project needs. 



HMITOOL Configuration Software Application Manual HMITOOL configuration guidelines 

202501(V1.0) 104 

¸ Monitor address: Read address. The control is applied to display the data; the monitor address is the data 

register address carrying data to be displayed in PLC or other connected devices. 

¸ Decimal Place: Display the number of decimal places for the data. 

¸ Font: Choose a general font or digital font. 

¸ Font size: Choose the size of the displayed font as needed. 

¸ Alignment: The default is Center. 

Õ Left: The numerical value displayed is in the left part of the display area. 

Õ Center: The numerical value displayed is at the center of the display area. 

Õ Right: The numerical value displayed is in the right part of the display area. 

¸ Justification: The default is zero-suppression. 

Õ Zero-suppression: Zero in front of the significant figure is hidden. If the value of the monitor address 

is 00123, a 16-bit positive integer, then the value displayed in the display box is 123. 

Õ Zero Header: Display the leading zero of the effective number of bits. If the value of the monitor 

address is 00123, a 16-bit positive integer, then the value displayed in the display box is 00123. 

Õ Space Header: Display the space instead of 0 in front of the significant digit. If the value of the 

monitor address is 00123, a 16-bit positive integer, then the value displayed in the display box is 

123. 

¸ Text Color: The font color of the data displayed; 

Note: 

Õ Shape, border color, foreground color, background color and style can be used with reference to "Bit 

button" control. 

Õ Double-click the data display box to reset the contents and properties of the data display. When the 

control functions in the HMI, an on-screen keyboard will pop up, giving an access to the data input for 

user. 

Õ The number of decimal place affects the data display. When the selected data type is 16/32-bit positive 

integer, 16/32-bit integer, and then the displayed value is acquired by offsetting the decimal point of 

return value by the set number of digits. If the value 212 is returned and the number of decimal places is 

2, then "2.12" is displayed. If the selected data type is a 32-bit floating-point number, the value has no 

offset; but only the fractional decimal places are displayed. If the value 2.123 is returned and the scale is 

set to 2, only "2.12" is displayed. 

Õ Total number of bits means the sum of the length of the integer part and the fraction part. If the integer 

length of the displayed value is greater than that of the integer part, the length of the displayed integer 

will be that of the actual value. For example, for the value 2123, the length of value is 2, and number of 

decimal place is 1, then it will display 212.3. 

The "Advanced page" of "Numeric Display" contains powerful functions, including "Scaling" and "Range 

Display", as shown in figure below: 
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¸ Scaling: When this option is selected, the data displayed by the numeric display control is: Monitor (Read) 

?bbpcqq T_jscÓ E_gl ) Mddqcr 

¸ Display Range: When this option is selected, user can set the lower and higher limit values as well as the 

low and high-level background color according to the needs. The address value monitored (read) by the 

control will be represented by different color patterns in the user-set lower and higher limit values. 

¸ Variable range: the values of "Lower Limit" and "Higher Limit" are dynamically changed, depending on 

the address entered by the user 

Õ Lower limit: Set the lower limit of the display. When the number displayed is lower than this limit, 

the background color will be the color set in Low Level Background Color. 

Õ Higher limit: Set the higher limit of the display. When the number displayed is higher than this limit, 

the background color will be the color set in High Level Background Color. 

For example, when you set the background color and text color in the General page and select the Range 

display color as shown in figure below: 
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